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End User Software License Agreement
IMPORTANT - PLEASE READ THIS LICENSE CAREFULLY BEFORE USING THIS SOFTWARE. BY CLICKING THE 
"ACCEPT" BUTTON OR BY USING THIS SOFTWARE, YOU AGREE TO BECOME BOUND BY THE TERMS OF THIS LICENSE.  
IF YOU DO NOT AGREE TO THE TERMS OF THIS LICENSE, DO NOT USE THIS SOFTWARE, AND PROMPTLY RETURN IT TO THE 
PLACE WHERE YOU OBTAINED IT FOR A REFUND IF APPLICABLE. IF THE PRODUCT DOES NOT HAVE A PHYSICAL PACKAGE, 
ERASE THE SOFTWARE AND ITS INSTALLER IMMEDIATELY.
IF YOU "ACCEPT" OR USE THE SOFTWARE, YOU ACKNOWLEDGE THAT YOU HAVE READ THESE  STATEMENTS AND 
AGREEMENTS, THAT YOU UNDERSTAND THEM, AND THAT YOU AGREE TO BE BOUND BY THEIR TERMS.  

The enclosed computer program(s) ("Software") is licensed, not sold, to you by InfoLogic, Inc. ("InfoLogic") for use only under the 
terms of this License, and InfoLogic reserves any rights not expressly granted to you.    

1. LICENSE.  
(a) InfoLogic grants you a non-exclusive license to install and use the machine executable, object code version of Software, related 

documentation, and updates thereto made available by InfoLogic solely for the purpose of using the Software in accordance with the accompanying 
electronic documentation.  

(b) You may use one copy of the Software on a single computer at a time. 
(c) You may use the Software for your own personal or internal business use and not in the operation of a service bureau or publicly 

accessible computer or for the benefit of any other person or entity. 
(d) You may make one copy of the Software solely for backup purposes, provided that all copyright and other proprietary notices are 

maintained on the copy of the Software.
(e) You may permanently transfer all your rights under this License to another party by providing to such party all copies of the Software 

licensed under this License together with a copy of this License and the accompanying written materials, provided that the other party reads and agrees 
to accept the terms and conditions of this License.

(f) Notwithstanding any other terms in this License, if the Software is licensed as an upgrade or update, then you may only use the Software 
to replace previously validly licensed versions of the same software.  You agree that the upgrade or update does not constitute the granting of a second 
license to the Software.

2. RESTRICTIONS.  
You may not use, copy, modify, or transfer the Software, or any copy thereof, in whole or in part, except as expressly provided in this 

Agreement.  You may not reverse engineer, disassemble, decompile, or translate the Software. Any attempt to transfer any of the rights, duties or 
obligations hereunder is void. You may not publish, display, disclose, modify, rent, lease, loan, resell for profit, distribute, or create derivative 
products based on the Software, or any part thereof.

3. TERMINATION.  
This License is effective until terminated. This License will terminate immediately without notice if you fail to comply with any provision 

of this License.  You agree upon termination to promptly destroy the Software and all copies thereof.

4. LIMITED WARRANTY.  
The software is provided to you "AS IS" and InfoLogic and its suppliers expressly disclaim all warranties and representations, express, 

implied or statutory including the implied warranties of merchantability, fitness for a particular purpose, and non-infringement.  InfoLogic does not 
warrant that the functions contained in the software will meet any requirements or needs you may have, or that the software will operate error free, or 
that any defects or errors in the software will be corrected or that the software will be compatible with any particular platform. InfoLogic warrants for 
a period of ninety (90) days from your date of purchase that the media, if any, on which the Software is recorded will be free from defects in materials 
under normal use.

5. LIMITATION OF REMEDIES AND DAMAGES.
In no event will InfoLogic or its parent or subsidiaries or any of the licensors or suppliers be liable to you for any lost profits, lost data, 

business interruption, loss of business information or cost of cover and the like, or other special, punitive, indirect, incidental or consequential 
damages of any kind arising out of the use or inability to use the Software or any data supplied therewith, or for any claim by any other party even if 
InfoLogic has been advised of the possibility of such loss or damages and whether or not such loss or damages are foreseeable.  In no event shall the 
liability of InfoLogic exceed the amount received by InfoLogic from you for this software license. 

6. COMPLETE UNDERSTANDINGS
By opening this package or using this Software, the user agrees to be bound by the terms of this agreement, which include the software 

license and the limited warranty. This Agreement applies to the user and any subsequent license of this Software. This Agreement shall not be 
modified except by a subsequently dated written amendment or exhibit signed by both parties by their duly authorized representatives

THE SOFTWARE IS PROTECTED BY THE COPYRIGHT LAW AND INTERNATIONAL TREATY.

Copyright 1996-2004, InfoLogic, Inc. All Rights Reserved.
support@mathmagic.com

 MathMagic User Guide - Personal Edition & Pro Edition v5.0 3 



I. Introduction to MathMagic

MathMagic, developed by InfoLogic, Inc., is an equation editor equipped with WYSIWYG interface 

and automatic formatting engine for editing mathematical expressions and scientific symbols.

MathMagic provides you with easy-to-use interface and various powerful features in creating and 

handling equations. With MathMagic, anyone can create any kinds of mathematical expressions in 

seconds, and easily use them within other software. You can easily create test sheets and class notes, 

technical reports, research papers, presentations containing complex mathematical expressions and 

symbols with the help of MathMagic.

MathMagic Personal Edition is a stand-alone application that runs on both Mac OS X and Classic 

environments. It is a general purpose equation editor for personal use.

MathMagic Pro Edition comes with more features than Personal Edition which interactively work 

with MathMagic Plug-in for Adobe InDesign software or MathMagic XTension for QuarkXPress 

v4~v6. This is for desktop publishers and high-end users who need to edit equations mainly within 

Adobe InDesign software or QuarkXPress application, while MathMagic Pro application can be used 

with other software like word processors as well.

MathMagic provides you with intuitive interface as shown above so that anyone can easily use it to 

create and edit any form of mathematical expressions in an on-screen editing environment. 

For experienced users who need more adjustments than the default settings, MathMagic also provides 

very flexible custom setting features like defining Spaces, Styles, and Sizes, with its intuitive graphical 

interface via Preferences dialog window. 
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Another beauty of MathMagic is to provide an unique keyboard based working environment, like 

Magic control key, predefined shortcut keys, and user defined shortcuts keys, for superior productivity 

in creating and editing equations.

Also, in order to meet the high quality output for desktop publishing, MathMagic comes with many 

quality fonts in TrueType and PostScript formats, and OpenType format as well.

For other MathMagic products including MathMagic Windows version, please refer to its own user 

guide or the web site: www.mathmagic.com
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1. Outstanding Features

1.1  Intelligent WYSIWYG Editor

MathMagic Equation editor is based on the WYSIWYG concept, and provides automatic formatting 

functionalities such as rearrangement, justification, width, thickness, size and spacing for each of 

templates, operators, operands, so that basically you don't need to worry about those factors while 

using MathMagic. You may also control and customize all those default settings via customizable 

preference values.

1.1  Easy-To-Use Interface

MathMagic helps you create and edit any mathematical expressions with its menu and palette-based 

user interface. The intuitive equation palettes help you create multiple combinations of mathematical 

expressions within a few clicks. The Equation templates and various symbols are well-organized in 

each palette by the meaningful category for easy and quick access.

1.3  Type-and-Draw via Keyboard

Though MathMagic provides well-organized template and symbol palettes for easy access via mouse, 

MathMagic exclusive keyboard access feature is added which is yet innovative input interface for 

advanced users as well as novices. With point-and-click interface, user may need to frequently switch 

between mouse and keyboard. To address this and improve the productivity for those who prefer to 

working with keyboard as much as possible, MathMagic has a simple and new interface that will 

reduce the need for switching between keyboard and mouse. Pressing the Magic control key will 

display corresponding keyboard shortcuts of each palette and its buttons. Pressing control and one 

of the on-screen key works as if the user clicked on the button. option-tab switches between 

Template and Symbol palettes. You may also try control-tab or shift-control-tab key 

for sequential switches through the palettes in turn.

With this on-screen shortcut key tool tip, user can easily access every single template and symbol 

without memorizing command keys or without mouse.

1.4  Support for any kinds of mathematical expressions

MathMagic can create almost all kinds of mathematical expressions ranging from elementary level to 

higher math. Those equations used wide area including Mathematics, Physics, Science, Statistics, 

Accountings, Electronics, and many Chemistry equations since there is no limit in MathMagic but in 

your imagination.
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1.5  Rich choices of high quality font sets 

MathMagic provides high quality TrueType and PostScript fonts specially designed for the field 

professionals created by professional font designers for wide range of choices.

1.6  Export in PICT, JPEG, GIF, EPS, PDF and TeX Format

You may save your works in the standard Macintosh PICT format for use with almost every other 

Macintosh applications including word processors or graphics applications. Also, JPEG and GIF 

format allow you to publish your works on the web across the platforms. And EPS format allows you 

to use your works for professional publishing. 

With the TeX export, you may easily create any complex mathematical expressions within MathMagic 

fast and use them in TeX document, freeing you from learning complex TeX.

1.7  Custom Clips and User Item Toolbar

Users can customize their own floating Toolbar for frequently used items of Template and Symbols. 

This will increase your productivity by allowing quick access to your favorite functions. Once 

registered to the User Item Toolbar, each item can be selected via control + shift - keys.
Users can save frequently used equations into the Clips window. With clips, you may improve your  

productivity more dramatically. Also you may assign your own shortcuts and names for any clips for 

easier access via keyboard. Each clip is saved in the "MathMagic User Data" folder in the 

Documents folder so that you can share your equation clips with others.

1.8  Flexible Custom Settings for Spacing, Style & Size, and StyleSet management

You can specify your own equation shapes more accurately with MathMagic. Equation gap, line width 

and thickness, overhang, box position, default font and style for Math, Variable, Function, Greek, and 

tens of other settings can be customized easily with visual interface thru the Preferences panel. 

All in your preferred units including point, q, mm, inch, and %(relative to the base font size). All as 

sharp as 2400 dpi accuracy.

All settings specified by user can be stored as a StyleSet for later use. Each StyleSet can remember all 

the Spacings, Styles, and Sizes which are specified in the Preferences dialog.

So you can compose your own best quality equations for the specific purposes like 3rd grade Text 

book, research paper, or Chemistry note under each StyleSet and switch among them quickly. You can 

also share the StyleSet information with other people within your team to synchronize the working 

environment.

1.9  Supports Color equations with style management
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MathMagic application supports color for colored equation. It allows you to specify various colors in 

equation templates and symbols. Colors are stored as styles and can be shared within your workgroup 

to set the same color environment for a project. All the specified colors can be easily changed later by 

changing the style from the color list, which saves your time a lot when editing many equations with 

colors.

2. Software Contents

After installation, you will find a MathMagic window like this. 

'

This folder, by default, is installed in the "Applications (Mac OS 9)" folder  in the root 

directory when installed on Mac OS 9, or "Applications" folder under root directory on Mac OS 

X, if other location is not specified by user.

MathMagic Installer will install some other files in the proper locations as well.

Please make sure that all components below are installed correctly.

:Applications:MathMagic Personal folder (or MathMagic Pro)
• MathMagic Personal Edition or MathMagic Pro Edition application
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• Documents
• Sample files

:Library:Fonts folder
• MathMagic fonts

:user:Documents:MathMagic User Data folder
• Default Clip files
• StyleSets:
• Color:

:user:Library:Preferences folder
• MathMagic 5.0 Pref

*Note: The software contents and install location may vary without prior notification.

3. System Requirements

Before installing and using MathMagic Personal or Pro Edition, you need to check that your system 

meets below requirements. Building mathematical expression invokes intensive internal computation, 

we recommend PowerPC G3 or later, running Mac OS 8.6 or later.

• Hardware : Power Macintosh or its Compatibles (G3 or higher recommended)
• OS : Mac OS 8.6 or later, 

CarbonLib 1.2 or later, 
Appearance Manager 1.1 or later

: Mac OS X 10.1.3 or later

• RAM : At least 8MB of available memory (Mac OS Classic)
• Hard Disk : About 15MB of available hard disk space for complete installation.

• Display : 800 * 600 or wider.

4. Other MathMagic products
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Other than the MathMagic Personal Edition, there are several other MathMagic products.

 • MathMagic Personal Edition: Stand-alone application for Mac OS X & Classic, and Windows

 • MathMagic Pro Edition for Adobe ® InDesign™: Stand-alone application and a Plug-in for use 

with Adobe® InDesign™, Mac OS X and Windows

 • MathMagic Pro Edition for QuarkXPress v4.x~v6.x: Stand-alone application and a XTension 

for use with QuarkXPress® application, Mac OS X and Windows

 • MathMagic Prime Edition: Customized versions for large publishers or a certain clients on 

top of MathMagic Pro Editions.

 • MathMagic XTension for QuarkXPress v3.3~4.1 for Mac OS 9.

You can find more information and download the latest updaters or trials at 

 http://www.mathmagic.com/ 

All installers come with fully functional Free Trial period, which can be switched to regular versions 

once authorized with a valid Customer # and Serial #.
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5. MathMagic Feature Comparison Table

Features \ Products MathMagic Pro MathMagic 
Personal

MathMagic XT for 
QuarkXPress v3~4

Platform Mac OS X, Winows Mac OS X/9, Winows Mac OS Classic only.

Main Components 1 App, 1 Plug-in, TT & 
PS fonts, OpenType 
fonts

1 App, TT fonts, 
OpenType fonts

1 XT, 1 Viewer XT, TT & 
PS fonts

Stand-alone application Yes, plus a Plugin or 
XTension

Yes No (XTension)

Available for Mac OS X Yes (Carbon) Yes (Carbon) No

Available for Windows Yes (Win 98~) Yes (Win 98~) No

OLE support(Windows) Yes Yes N/A

Floating Toolbar Yes Yes No

UI & Palette design Color palettes Color palettes Black&White based

Detachable floating 
palettes

Yes Yes No

Integration with 
QuarkXPress

Excellent (XPress 
v4.1~6.0)

Good Excellent (QuarkXPress 
v3.3~4)

Integration with InDesign Excellent Good No

Integration with Other Appl Good Good No

WYSIWYG editing Yes Yes Yes

View rate 100~3200% 100~3200% 100~3200%

PostScript fonts bundled Yes No Yes

Color support for Equation since v4.0(Mac), 
v2.0(Win)

since v4.0(Mac), 
v2.0(Win)

Partially (Quark's color 
menu)

EPS export(Gray, B&W) Yes Yes (B&W only) Yes (B&W only)

Color EPS export Yes No No

TeX support Import/Export, Copy 
as TeX

Import/Export, Copy 
as TeX

Import/Export

Macro / Clip support Yes (unlimited #) Yes (unlimited #) Yes (multi-set, 
unlimited #)

Font / Size / Style changes Flexible Flexible Flexible

Baseline Savvy Equation Yes Depends on target 
app

Yes

Drag&Drop To/From other 
applications

Yes Yes No

Multiple Preference set Yes (StyleSet) Yes (StyleSet) Yes (Environment DB)

Magic control key 
navigation

Yes (control key) Yes (control key) No

Nudge movement for 
selection

Yes Yes (short distance) Yes

Wheel mouse scroll Yes(OS X & Windows) Yes(OS X & Windows) No

Academic pricing Available Available No

TeX spacing rule editiing Yes Limited No

Multiple Undo/Redo Yes Yes No
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II. Installation

1. Using Installer

Please use the MathMagic Installer for easy and proper installation of all necessary components in the 

right locations.

Each version of MathMagic products comes with its own installer normally.

The installer can be found on the MathMagic CD if you bought a physical package, or you can get it 

by downloading from MathMagic.com web site. If you download the installer, you may need to 

decompress it with Stuffit Expander utility if it is not automatically decompressed.

Please launch the installer.                      

After you accept Software License Agreement, and read the ReadMe contents displayed by the 

installer, the following "Easy Install" window will be displayed.

Click "Install" button to begin installation. The installer will place all necessary files in their respective 

locations. 

If you are using Mac OS 9 or earlier, since new fonts and some system level extension are installed 

into the current System, it is recommended to restart your Mac after installation. You may change the 
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Install Location by switching disk to another, or selecting another folder.

When you are installing MathMagic on Mac OS X with Classic(Mac OS 9) on top of it, please make 

sure that you install MathMagic fonts in the OS 9's System folder as well so that those Classic 

application can also display equation PICT correctly with correct fonts.

2. Uninstalling

MathMagic Installer can also be used to uninstall MathMagic components that were installed with the 

installer. 

Please click on the "Easy Install" pop-up button and choose "Uninstall" menu. Then click "Uninstall" 

button on the right bottom.

You may manually remove all or some of those installed files. In the MathMagic folder, you can refer 

to "MathMagic Install Log" file to find out all installed files and locations.

3. Finding the latest version

The latest version of MathMagic is available from the MathMagic web site.

For the available downloadings, please refer to the web site. 

http://www.mathmagic.com/download/

If you bought a physical package, you may also want to check the download page before you install 
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from the CD so that you make sure you install the latest version.

If you want to buy the latest MathMagic Personal Edition or MathMagic Pro Edition from the 

MathMagic online store, please visit

http://www.mathmagic.com/store/

You can also find a Local Reseller information near you on the web site if you want to buy a physical 

package near you.

http://www.mathmagic.com/support/

Once you complete user registration from the MathMagic web site, you’ll later be informed when a 

new version is available.

4. Authorizing your copy with a Serial code

You may run MathMagic without authorization serial code for a while as a fully functional Trial demo 

mode. 

To authorize your copy of MathMagic Personal or Pro, however, on your specific Macintosh machine 

and make it run without displaying the Trial Nagging message, it is required to enter a valid User 

Name, Customer number and Serial number string in the Authorization dialog.

Registered user thru the web or email should receive both a unique Customer number and Serial 

number string via e-mail for the activation of his/her own copy along with the latest news and services 
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offered by the developer. Normally the Serial code will be delivered within 1 business days. But the 

different National holidays and time zone may cause a delay of a few more days. If you did not hear 

from MathMagic support team for more than 2 days, please contact us again via email.

Customer number(or Product #) looks like this.

XXXXXX-XXX-XXXXXXX 

Serial number looks like this.

XXXX-XXXX-XXXX 

Older versions may have a different format.

After you enter both a customer number and a serial code correctly, press "Authorize" button and it 
will confirm your code.

Until the demo trial period expires, you may use the software with fully functional Trial mode by 

pressing "Try" button from the Authorization window. This will reduce your trial count and it may 

take more time to open a new window as trial count increases. 

If you press "Quit", it will just quit without reducing the trial count.

You may visit MathMagic Online store by pressing "Buy" button thru your preperred web browser.

Please note that your Serial Number may encodes the expiration date of your copy depending on your 

subscription period. If you bought a full version, not a subscription version, you may use your copy 

even after the expiration date. But free upgrade is no longer available after the expiration.

Please visit MathMagic web site for the latest licensing policy since it might be changed to better serve 

our customers and to meet the trends.

Once you authorize your copy, the application will run without displaying the Authorization nagging 

dialog.

For some reasons, when you need to open the Authorization window again, please open the 

"About MathMagic..." splash window from Apple(or Application) menu. There you will find 

a button to open the authorization window. 

Or, you can find "Enter Authorization Code..." from Help menu as well.
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Here, you can enter a new User name, Customer number or Serial number to change the 

ownership or to extend your Free Upgrade period or Subscription period.
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III. Using MathMagic

1. Windows

MathMagic gives you a WYSIWYG editing window with a set of palettes and  floating windows 

consisting of Template, Symbol, User Item Toolbar, Clips window, Color window, and tear-off 

floating palettes as shown in the below picture.

 

Main Toolbar User Item Toolbar Clips window

Floating Palettes
(Template & Symbol)Palette switching Tab

Popup Palettes barMenu bar Document window

Current Style name
View rate Insertion Point

Empty Slot

Selection

Color window
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1.1 Document window

Mathematical expression is created in the document window by selecting an equation shape from the 

Template palette and entering numbers / variables / symbols into the given slots. For details about how 

to use those palettes, refer to the Palette section. 

MathMagic supports multiple document windows, so you may create different equations in their 

respective windows simultaneously. Drag and drop any selection into other window will copy & paste 

the selection.

Document window support multiple view rates from 100% to 3200%. The default view rate is 300%, 
which can be changed by user at Preference -> Misc. pane.

• Empty Slot: An empty slot is displayed with a solid gray outline.
• Insertion Point: A cursor consisting of a vertical line and a horizontal line indicates 

where text, templates, and symbols will be inserted next.
• Selection: The highlighted part of the equation is a selected area and will be modified by 

any subsequent editing commands.

1.2 Main Toolbar

Font Style Size StyleSet Alignment

Line Spacing

Preferences Dialog

Size Adjustment

Refresh window

Undo/Redo

User Item Toolbar

Clips window
Color window

Show/Hide 
palettes

Nudge 

Resize Toolbar

Floating Main toolbar contains several frequently used items for easy access via mouse clicks. It also 

provides users with visual information for the current situation including font and size of current cursor 

position, undo/redo count, and so on.

Main Toolbar can be selected from Windows menu when it is not displayed.

• Font popup menu: Used to change the font of the selected part of the equation.
• Style popup menu: Used to change the style of the selected part of the equation.
• Size popup menu: Used to change the font size of the selected part of the equation. 

 (OS X)       (OS 9)
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Clicking on the Up arrow or the Down arrow button next to the Size popup menu will 
increase or decrease the font size of the current selection by 1 point. control-clicking on 
the arrow button will increase or decrease by 0.1 pt. When the default Size unit is other 
than point(pt), the unit for Size popup menu will also be changed .

• Line Spacing button: Used to increase or decrease the line spacing of the current 
document or the current cursor location if nested. Clicking on the button previous to the 
Line Spacing button, will display the Line Spacing Dialog Box.  Control-clicking on 
Increase/Decrease button will allow user more accurate adjustment of one tenth unit.

• Alignment button: Used to change the alignment of the current rows: left, center, or right.
• Undo/Redo button: Used to undo performed actions or redo undid actions. It also displays 

how many Undo/Redo recordings are maintained. The maximum value can be changed in the 
Preferences->Misc. dialog window.

• Refresh button: Used to redraw all the current document contents when there is garbage 
on the editor window.

• Preference Dialog: Used to bring up the Preference dialog.
• Clips Window: Used to show or hide the Clips floating window.
• Color Window: Used to show or hide the Color floating window.
• Nudge Window: Used to show or hide the Nudge floating window.
• Show/Hide palettes: Used to show or hide all floating Template & Symbol palettes, 

remembering their locations, to give user more viewable area temporarily.
• User Item Toolbar: Used to show or hide the User Item Toolbar.
• Resize Toolbar: manually adjust the size of the current main Toolbar.

1.3 User Item Toolbar

Floating User Item Toolbar is a container of frequently used Template items and Symbol items. It 
comes with pre-registered items as shown above or similar. But all the items can be registered and 
rearranged by user again.

To register an item to the User Item Toolbar, select an item with mouse from Template palette or 
Symbol palette while pressing command key. 
To remove any item from the User Item Toolbar, click on the item in the Toolbar while pressing 
command key.

To rearrange the order of items in the Toolbar, drag the item and drop on where you want to place.

To select an item from the User Item Toolbar, you can either click on the item or press control-shift-
shortcut key displayed as a tool tip while pressing control key.
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The location of Toolbar window is remembered even after you quit the application. So you can place 
the toolbar location where you like.

The items list and order are saved in the preference file(MathMagic Pref) in the Preference folder so 
you need to be careful when you delete the preference file or reinstall/update MathMagic.

1.4 Clips window

Clips floating windows is for saving frequently used equation clips for later use.

User can register an equation clip from a document window to the Clips floating window by dragging 

it from document window onto the Clips window, on it, or by pressing command-M shortcut key after 

selecting the part that you want to register.

When registered, each clip will be automatically named with the document window's title name plus a 

sequential numbering. If you want to change the Clip name, click on the Name area at the bottom of 

the window and assign a new name.

Registered item can be double-clicked or drag&dropped to be entered into the current cursor 

position of the topmost document window.

Selected item can be rearranged to the begging or to the end by pressing Arrow button below the list 

area.

The Clip items are saved in the "MathMagic User Data" folder in Documents folder.

On OS X, User Home:Documents:MathMagic User Data:Clips:Default:
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On OS 9, Startup disk:Documents:MathMagic User Data:Clips:Default:

Each clip is saved as a PICT format in each file. User can share the Clip files with others to share the 

frequently used equation clips within the group or with other friends. User can copy Default folder 

itself or specific items from the folder to others and add those files into the Default folder. Then, newly 

added items will be recognized when MathMagic starts next time.

1.5 Color window

MathMagic v4.0 or newer supports colored equation. The color interface is designed to manage two 

different Color style set: Application Color list and Document Color list. Once you or your team 

created a series of color styles, you can easily use those colors and change later more conveniently.
 

For more information about using Color window or colors in the document, please refer to the 

following location: VI. 9. Using Colors

1.6 Palette windows

Template toolbar:

Symbol toolbar: 
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Pop up palette:

All Template and Symbol palettes can be detached from the toolbar and reside as floating palette 

windows. After clicking on a specific button item in the toolbar and having it popup, user can drag the 

popup palette window out of the rectangle to the bottom area to detach. 

Once detached, it remembers the location and will be displayed again when MathMagic runs next time.

To close all opened palette windows at once, user can click on the close box while pressing option key.

command-click on an item will register the item to the User Item Toolbar.

2. Menus

2.1 Application Menu

If you run MathMagic on Mac OS X, there will be an application menu as shown above. 

On OS 9 or earlier, there is only About... menu item under Apple menu and Preferences item can be 

found under Edit menu. Quit item can be found under File menu.

Please refer to the Edit menu for the details of Preferences window.
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When you quit MathMagic application, it stores the current opened floating windows' size and their 

locations in the MathMagic Pref file located in the Preferences folder.  When you run MathMagic 

again, it restores the last status as much as possible for your peaceful working environment.

It also asks you whether to save or not if there are any unsaved windows.

2.2 File Menu

  

File menu consists of basic menu items for creating new document, opening document created before, 

saving/exporting your works, or printing. 

The menu items are different  depending on Mac OS X and Mac OS Classic.

You may save your work in MathMagic own format. The saved document can be opened by 

MathMagic XTension within QuarkXPress too since they have compatible file formats.

Export supports PICT, GIF, JPEG, EPS, TIFF, and TeX formats for use in other applications. 

If you want to save your work as a PDF format, you may do that by selecting "Print" menu item and 

the "Save As PDF..." button on the Print dialog on Mac OS X.
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MathMagic Pro Edition

If the current MathMagic editor window is originated by InDesign or QuarkXPress, the window's title 

will show the original document name of InDesign or QuarkXPress so that you can understand which 

equation window is related to which InDesign or QuarkXPress window.

If the current equation editor window is originated by InDesign, the File menu item will also be 

changed. 

If the current equation editor window is originated by QuarkXPress, the window title and the above 

File menu item will display QuarkXPress instead of InDesign.
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2.3 Edit Menu

   

• "Undo" or "Redo" supports multiple reverts up to 50 times. You can set the depth level in the Misc. 

panel of Preferences window. The more level you specify, the more memory MathMagic consumes.

• "Paste" works within MathMagic application. At the moment, MathMagic does not support 

clipboard from other application fully. You may copy a selection from MathMagic and paste it into 

other application as a PICT format.

• "Copy As TeX" copies the current selection as a TeX format so that you can paste it in your TeX 

editor. This will helps you create equations with WYSIWYG beauty even though you are not fluent 

in TeX language.

• "Template Input follows", "Symbol Input follows", and "Greek Input follows" marks the 

following key stroke is for its shortcut keys. For example, pressing cmd-G, and then "a" will insert 

greek lowercase alpha(α).

For the full shortcut keys table, please refer to the Appendix of this User Guide. 

• "Make a Clip" menu adds the current selection into the Clips window.

• "Use Magic control key" lets you turn On or Off the Magic shortcut key. Please refer to VI. 2. 

Keyboard Shortcuts.

• "Register Shortcuts..." menu allows you to configure your custom keyboard shortcuts for any 
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equation clips or user items. For details on how to assign shortcuts, refer to "VI. Advanced Features".

• "StyleSet..." allows you to manage the settings environment of Spacing, Style, and Size values of 

Preferences window as a set. Most of the important custom setting environment is stored under a 

StyleSet name. You may configure several working environments with this StyleSet feature and 

switch among them quickly.

StyleSet is stored as a file in the :user:Documents:MathMagic User Data:StyleSet: folder. So you 

may want to share the files with your colleagues to have the same working environment among team 

member.

• New is to create a new StyleSet name. The current Spacing, Style, and Size settings is stored under the 

name.

• Reassign is to assign the current(topmost) window's Spacing, Style, and Size setting values to the 

selected StyleSet name.

• Rename is to rename the selected StyleSet name.

• Delete is to delete the selected StyleSet name.

• Make Default is to make the current selected StyleSet values as a default value when a new editor 

window is opened.

• Preview is to set the current selected StyleSet values to the topmost editor window.

• Cancel closes the StyleSet dialog window without applying what you have applied.

• The "Preferences..." menu allows you to configure many custom settings in 5 categories.

• Misc. tab
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• In the Misc. tab, you can specify several global settings. The setting options listed in the Misc. tab are 

applied to all equation editor windows that are opened after this setting. 

You may choose default space width from the given list in the pop up menu. 

Undo menu remember up to 50 previous actions. Most commands and behavior within the editor window 

are undo-able and redo-able except modifying Toolbar or Clips window. User can Redo all the Undo 

actions.

Default zoom ratio of the editing window can be selected from 100% up to 3200%. 

By specifying Copy & Export ratio, when you copy a selected equation, you can make it big with other 

view rates than 100% so that you can use the equations on other applications more visually.

Cursor movement order can be specified by user as well. When Western is selected, cursor will go to the 

numerator slot first, and then to the denumerator slot.

You can turn on and off Auto Recovery feature as well. While turned ON, you may temporary discard it 

by pressing 'shift' key during the application launch. 

• Spacing tab
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• In the Spacing tab, you can specify gaps, spacings, shapes, ratio, or thickness of several important 

Templates. Each user may has his/her own preferences in making the equation depending on the country 

or publishers or personal habits. In this tab, user can customize the settings.

User can press on the button listed above and see the setting options for each template. If you click on a 

field, it will show you visually on the right side how and where it will affect. For details on this command, 

refer to Chap. VI  Advanced Features. 

• Style tab

• In the Style tab, you can specify 10 mathematical styles used by MathMagic depending on the context 

where the cursor is located. The setting options listed in the Misc. tab are applied to all equation editor 
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windows. When you enter a string in the editor window, MathMagic automatically recognize the context 

and set the pre-defined style information specified here. For instance, if you enter a number, it will set the 

font name to MMTimes.  For details on this command, refer to Chap. VI  Advanced Features. 

• Size tab

• In the Size tab, you can customize sizes of several standard slots of mathematical equations. 

For the Full size, the unit should be an absolute unit, like Point(pt), Queue(q), mm or inch. Other items 

can have both absolute unit or relative unit(%) value. Percentage(%) means the size relative to the Full 

size. For details on this command, refer to Chap. VI  Advanced Features

• Shape tab

• In the Shape tab, you can customize some default Symbols shapes.
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2.4 View Menu

You may choose the zoom rate of the current editor window from the View menu. Each editor window 

can have its own view rate at any time during the editing. 100% is the actual size of the equation being 

edited. The current magnification is marked at the beginning of view value in View menu, or at the 

bottom of the editor window. 

The magnification is provided for screen view purpose for easier editing and fine adjustment. When 

copied, or drag&dropped to other application, or exported, the ratio specified in the Misc. tab of the 

Preferences will be applied. EPS and TeX export are not affected since they are not view rate 

dependent much.

Default value for a new document window can be specified from Misc. pane in "Preferences" window.

Refresh item updates and redraws the current document window. Editing equations may result some 

afterimages due to intensive computation and drawings. If the screen is not what you expected or 

seems to contain some garbage images, use the Refresh menu item.  This can also be selected as a 

button from the Main Toolbar.

Show Controls displays or hides the hidden control characters like space or alignment base.

Show Baselines displays or hides the baseline location of each slot in dotted red line, and global 

baseline position in read line. The global baseline should be vertically aligned with the baseline of the 

text line when it is inserted in a text line as a inline graphic object for best editing quality result. The 
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baseline information is stored in every MathMagic equation object(PICT, EPS) so it is automatically 

aligned if the target application support the Baseline Savvy feature, or MathMagic Plug-in or 

MathMagic XTension is loaded in InDesign or QuarkXPress.

Show Bounds displays all bounds of each component showing you when it is located and how tall and 

how wide. In case you need to check the exact size or location of each component, you may turn this 

on for temporary use. The out most whole bound is in blue line and each component is in blue dotted 

line.

Show Empty Slots displays all empty slots in gray line of rectangle, showing you that those boxes are 

empty and expected to enter some values. The slot box frame is only for screen display to help your 

editing, not for printing. Difference between ON and OFF is displayed below.

  

2.5 Font Menu

You can change the text styles of the selection directly from the Font menu. When you need to specify 

a specific font within an equation editor window, the change won't be applied to templates or symbols 

other than normal text.

Before you apply a new font, you must first select a text block. Otherwise, the selected font will be 
ignored by the default Font Style specified by the equation engine. Refer to the Style menu below for 
the default style.
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2.6 Style Menu

Math Default

This will apply Math style to the selection. This can be customized from the "Style" tab of Preferences 

window. Normally it reformats the current selection to the default styles for each part.

Function

This will apply Function style to the selection. MathMagic recognizes common Function names such 

as sin, cos, log,  and automatically changes its style to straight & bold. If MathMagic won’t recognize 

a specific expression as function, use this command to force its style to straight & bold. This can be 

customized from the Style tab of Preferences window. 

Here are the Function name list currently recognized.
Im, Pr, Re, arccos, arcsin, arctan, arg, bmod, cos, cosec, cosh, cot, coth, cov, csc, deg, 
det, dim, exp, gcd, glb, hom, imz, inf, injlim, int, ker, lg, lim, liminf, limsup, ln, log, 
max, min, mod, pmod, projlim, rez, sec, sin, sinh, sup, tan, tanh, varinjlim, varliminf, 
varlimsup, varprojlim
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Variables

This will change the selection into Variables style. This can be customized from the Style tab of 

Preferences window.

Number

This will change the selection into Number style. This can be customized from the Style tab of 

Preferences window.

Text

This will apply Text style to the selection. This can be customized from the Style tab of Preferences 

window.

User 1 and User 2

This will apply User 1 or User 2 style to the selection. This can be customized from the Style tab of 

Preferences window.  This will be useful if there are frequently used styles for a certain tasks.

Plain

This will apply Plain style to the selection.

Bold

This will apply Bold style to the selection. 

Italic

This will apply Italic style to the selection.

Please note that other styles than Bold and Italic are not supported by MathMagic since they are not 
used commonly in the mathematical expressions.

Plain Large Symbol and Bold Large Symbol

This will apply Bold style or switch back to Plain style to the selected template or left template of the 

current cursor position. Fences, Fractions, and other templates that use symbol character or line inside 

the template will work with these two items.

Define Styles...

This will bring up the Define Style tab in the Preferences dialog window.

Auto Apply Styles...

User can turn on or off the automatic style setting feature of MathMagic engine. 
MathMagic Personal Edition may not support some of these items.
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2.7 Size Menu

In this menu, you may change the size of each slot in an expression to Full, Subscript, Sub-subscript, 

Symbol or Sub-Symbol. Also, you may specify other size from this menu.

Full

This will change the selected  block to default size. This can be customized from the "Size" tab of 

Preferences dialog box.

Subscript

This will apply the Subscript styles to the selected block.

Sub-subscript

This will a apply the Sub-subscript style to the selected block

Symbol

This will apply Symbol size to the selected block.

Sub-Symbol

This will apply the Sub-Symbol to the selected block.
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Other...

This will allows you to enter the exact size as needed. You may specify 1.000 ~ 127.999 by 0.001 

sharp unit.

+1pt, +0.1pt, -1pt, -0.1pt allow you to change the currently selected font size to bigger or smaller, 

just from Keyboard shortcut keys. 

Define Size...

This will bring up the Define Size tab in the Preferences dialog window.

Change Size Unit...

This will allow user to change and set a preferred default unit for font size.

2.8 Color Menu

Color menu is newly added since v4.0. With this menu you can create a color style for the current 

document, and specify a color for the current selection or current cursor location.

MathMagic supports two Color lists: Application color list and Document color list. Color list shows 

you all the color styles with name and its color in the order of creation. 

The Color menu takes care of the current document's color list. So when you switch to another 

document, the Color list will be changed to the document's color list.

All the color list and more color management features are also available thru the Color floating 

window. Please read the following section for more information: VI. 9 Using Colors.

MathMagic supports a color style with a style name. After you create a color style with a name and its 

color, and you apply the color to the document, you can later change the color easily just by 

Reassigning a new color to the style. Then, all the color used in the document will be automatically 

changed at once. This is very productive when you use several colors in a book editing with colored 

equations and want to change them to other colors later for some reason.

New Color...

 MathMagic User Guide - Personal Edition & Pro Edition v5.0 35 



You can create a new color style that belongs to the current document. It first displays System's 

standard Color Picker window for you to select a color that you want, and then another dialog to enter 

a color style name. The comma(,) is not allowed in the color style name.

Once created, it will be appended to the current document's color list on both Color menu and Color 

floating window.

Show / Hide Color window

This item is to show or hide the floating Color window. 

The same item is also available under Windows menu for convenient use.

Color style list

Normal Text, Question&Answer, or whatever color styles you created or transferred from Application 

Color list, will be listed below. And the current color of the cursor location will be Check-marked on 

the left side of the menu item. 

Normal Text is a predefined default color style that has a black color. There are several predefined 

color list in the Application Color list.

2.9 Format Menu

 

Align Left

Aligns the equations within matrix or multi-lined equations to left-hand side.

Align Center

Aligns the equations within matrix or multi-lined equations to center.
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Align Right

Aligns the equations within matrix or multi-lined equations to right-hand side.

[Note] In one-line equation, Align Left / Center / Right  will be dimmed. These menu items are for multi-lined 

equations.

Align Top

Aligns the equations within matrix to top. In other cases, this menu will be dimmed.

Align Base

Aligns the equations within matrix to the baseline. In other cases, this menu will be dimmed.

Align Bottom

Aligns the equations within matrix to bottom. In other cases, this menu will be dimmed.

Matrix Reloaded sub-menu

Matrix Reloaded sub-menu allows user to change Matrix after created so that user does not need to 

create a matrix from the scratch when he/she want to add or delete rows or columns.

[Note] Align Top / Base / Bottom and Matrix Reloaded will only be enabled when the cursor is in a Matrix box.

Nudge sub-menu 

After selecting a certain part to move, you can press one of four arrow keys while pressing option key. 

This will move the current selection to the desired direction 1-point on the screen of the current view 

rate.

Show / Hide Nudge palette

Show or hide the following Nudge control window. It has buttons that let you move the selection to 8 

directions by one pixel and two fields that you can specify the distance horizontally and vertically.  

The value means absolute distance in point unit in 2304dpi resolution, which is 3200% view rate of 

72dpi. So if you move 1 pixel in 3200% view rate, the value is 1. Or, 1 pixel in 100% view is 32. You 

can see some more help if you extend the window down with the Resize control.

MathMagic Personal Edition has a limitation for the maximum distance up to -64 ~ +64 that can be 
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moved.

Define Spacing...

This will bring up Define Spacing tab in the Preferences dialog. 

Fence Alignment...

This menu item displays a dialogue box to define fence alignment when the height of fences needs to 

be matched with baseline. 

This item will only be enabled when the current cursor is located next to or in a Fence template object.

Rotate Fence Alignment

This allows user to change the current fence alignment setting to the next setting without opening the 
above Fence Alignment dialog. It will rotate Base, Center, Base Fixed, Center Fixed, Normal, in turn.

Root Alignment

This will display a dialogue box for specifying the alignment within radicals. This item will only be 

enabled when the current cursor is located next to or in a radical template object.
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Rotate Root Alignment

This allows user to change the current root alignment setting to the next setting without opening the 
above Root Alignment dialog. It will rotate Base and Center in turn.

Minimum Box Height...

This will display a dialogue box for specifying the minimum box height for the current box. .

This item will only be enabled when the current cursor is located in a Full size box, 

Subscript/Superscript box, or Sub-subscript box.

 
For a certain cases, user may want to keep the descent height same over multiple boxes to maintain the 
same heigh regardless of the content characters's bounding area, as shown below

   

This Minimum Ascent value and Minimum Descent value are specified in Define Spacing->Char/Line 

spacing pane as shown below. 
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Rotate Min. Box Height

This allows user to change the current Box Height setting to the next setting without opening the above 
Minimum Box Height dialog.

2.10 Window Menu

Here, user can select a document window directly among many opened windows. This is especially 

useful when many windows are open on the screen and hidden by other windows on Mac OS X.

Main Toolbar, User Item Toolbar, Clips window, Color window and Nudge palette can be shown or 

hidden from this menu.

2.11 Help Menu

Some useful information on the MathMagic.com web site is available here. Once you select an item, 

it will launch your preferred web browser and connect to the corresponding web page.

Enter Authorization code... item will let you enter or re-enter your Customer # and Serial # for the 

authorization of your copy or renewing your previous authorization.
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3. Templates and Symbols

MathMagic provides many predefined mathematical expression shapes in Template palettes, 

organized by meaningfully categorized groups.

MathMagic also provides many mathematical or scientific symbol characters in Symbol 

palettes, organized by meaningfully categorized groups.

These Templates and Symbols are the core of the mathematical equations and documents. 

Based on the default Templates and Symbols, user may have any combinations or create a 

new Templates. User can also freely use many other fonts for their variety of purpose even 

though they are not predefined in Symbol palettes.

All palettes are accessible via mouse clicks to select a specific template or symbol button. You 

may also navigate palettes with key combinations and select a template or symbol with key 

strokes only.

[Shortcut Key Reference]
• Switching between Template and Symbol: Control-Tab

• Switching Palettes within Template or Symbol: Option-Tab

• Selecting a Palette: Option-Number or Alpha, shown as a tool tip

• Selecting an item from the palette: Number or Alpha, shown as a tool tip
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3.1 Template Palette

Template Palette provides templates that represent equation structures and shapes. Each 

template icon represents a category of similar shapes. This palette can be accessed by pressing 

control-tab or just one mouse click on the Template tab.

 (Mac OS X)

  (Mac OS Classic)

If you press a Magic control key, it will display shortcut key in a yellow tool tip box. So you 

can easily and quickly select a specific palette with control-key combination with no need to 

memorize. 

To explore all available Template palettes, read the chapter IV.  - 1. Template palettes.

3.2 Symbol Palette

Symbol palette provides various mathematical and scientific symbols and are well-organized 

for easy lookup. This palette is also handled by keyboard (control-tab) or click on the 

Symbol tab.

  (Mac OS X)

  (Mac OS Classic)

If you press a Magic control key, it will display shortcut key in a yellow tool tip box. So you 
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can easily and quickly select a specific palette with control - key combination with no need 

to memorize. 

To explore all available Symbol palettes, read the chapter IV.  - 2. Symbol palettes.

4. Toolbars and Floating windows

4.1 Main Toolbar

Main Toolbar provides some useful visual information as well as globally used items for the 

productivity. 

4.2 User Item Toolbar

User Items palette provides a convenient place that can store frequently used templates and symbols 

for easier and quicker access. Once added in the User Item palette, any templates or symbols can be 

assigned custom keyboard shortcuts. 

These user items are easily added or removed by mouse click while pressing command key. 

This palette can be toggled from the right-end button of Main toolbar or Windows menu.

Each item in the User Item Toolbar can be selected at any time via the Magic key of control-shift 

shortcut key, or with a mouse click. If you press option-shift key, it will automatically display its 

shortcut keys in the tool tip box on top of each button.
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You may register any buttons into the User Item Toolbar by command-clicking on the Template or 

Symbol palettes. 

You may move a item within User Item Toolbar by drag&drop to rearrange the order depending on 

your preference.

You can delete an item by command-clicking on the item.

• Adding items to User Item Palette
Choose your preferred templates or symbols as many as you want while pressing COMMAND key. 

This will add the selected items into the User Item palette.

• Removing items from User Item palette
Click on the button to be removed while pressing COMMAND key. This will remove the 
selected item from the palette. Please note that this command is not undoable.

4.3 Clips window

The Clips window provides one-click interface for entering any mathematical expressions. Also, any 

clip can be assigned with a fully customizable keyboard shortcut if you click on the More triangle and 

expand the Clips window. Shortcut keys for clips can also be specified thru the "Register Shortcuts..." 

command in Edit menu.

This floating window can also be selected from the button in the right side of Main Toolbar, or from 

Windows menu.

In order to add a clip to the Clips window, select a part or all of an expression from the document 

window and then press command-M. Or you may drag the selection into the Clips area for the same 

result. 
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Select a clip and press the Trash icon to delete it.

5. Using Keyboard Shortcuts

Pressing control key within the editor window of MathMagic will display its built-in hot keys of for 

the current palette items. Typing the given hot key characters (alphabet or number) will display 

respective popup menus.

And releasing the control key will display the built-in hot keys of every buttons in the popup menu. 

Then, press the given hot key to input a selected template or symbol.

Press control + any key -> Release control -> any key

This hot key feature is also applicable to the Symbol palette and the User Item palette.

[Note]
In order to take advantage of this feature, the keyboard layout should be switched to the 

Roman script. 2 byte language scripts may not be compatible.

6. Importing & Exporting

The document created by MathMagic is stored in MathMagic's own format normally. And it can also 

be exported to any of the following formats for use with other applications:

- GIF, JPEG, PICT, EPS, TIFF, TeX
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This conversion is available by "Export..." command under File menu. Among the following Export 

options, you can choose a format you want to convert to. 

If you intend to edit equations again later, it is recommended to store in MathMagic's own format or 

as an equation clip thru the Clips window. The EPS & PICT formats, however, can be opened by 

MathMagic later again if the file is saved by MathMagic v3.5 or later. Equations exported in GIF & 

JPEG formats are not editable.

And if you select and copy mathematical expressions within the editor window, the content copied 

into the clipboard as PICT format. When you select a format from pop-up menu as shown in the 

above picture, corresponding extension will be added at the end of the given file name.

The "Import..." sub menu is supported since MathMagic v3.5.

But it supports TeX format only for now.

EPS and PICT formats exported by MathMagic v3.5 or later, can be opened thru the Open... menu.

7. Printing
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MathMagic supports simple printing for the current document window.

Printing is done thru QuickDraw with some QuickDraw enhancements for high quality printing. It 

supports both non-Postscript QuickDraw printers such as Ink Jet printers, and PostScript printers such 

as LaserWriter. But even on PostScript printers, MathMagic will just print thru QuickDraw and 

MathMagic will not support native PostScript printing even though MathMagic has the ability to 

export to EPS format that can handle PostScript. 

MathMagic XTension supports native Postscript printing though.

The current version of MathMagic does not support printing preview or pagination for big multiple 

page contents. It just print 1 page at the moment.

If you want to print in high quality on Postscript printers, you need to export the equation as an EPS 

format and print it on other word processor or graphic application. 

8. Using MathMagic Pro with Adobe® InDesign™ and QuarkXPress®

MathMagic Pro Edition is an equation editor mainly for use with Adobe InDesign software or 

QuarkXPress in editing any mathematical expressions and symbols with WYSIWYG interface and 

various powerful features that meet DTP users' requirements.

There are two MathMagic Pro Editions available at the moment. 
- MathMagic Pro application for Adobe InDesign
- MathMagic Pro application for QuarkXPress

And more Pro Edition will be available in the future, for example, MathMagic Pro Edition for Adobe 

InCopy.

MathMagic Pro Edition is composed of
- MathMagic Pro application
- MathMagic Plug-in for Adobe InDesign, or - MathMagic XTension for QuarkXPress
- MathMagic fonts(both TrueType & PostScript)

MathMagic Plug-in or XTension provides you with the user interface(a menu and a tool button) which 

enables you to create and edit equations inside the InDesign document or QuarkXPress document.

Then, it communicates with the external MathMagic Pro application seamlessly.

You can make any equations with MathMagic Pro application very fast, and then send it back to 

InDesign or QuarkXPress. MathMagic Plug-in or XTension allows you to place equations inside a text 

box as inline graphics, or floating graphic objects in EPS format. Once created, all equations are 
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handled by InDesign application or QuarkXPress applicaton just like other EPS graphic objects. But 

you can still edit those equations anytime just by double-clicking on it or control-clicking on it to bring 

available contextual menu.

MathMagic Plug-in or XTension recognizes the baseline of equations automatically so that all 

equations match well with the baseline of the text line in the InDesign or QuarkXPress document, even 

though it allows you to shift the baseline manually as well.

8.1 Installing

You can install all required components in the right locations by using your MathMagic Pro Installer 

for Adobe InDesign or QuarkXPress.

The MathMagic Pro for Adobe InDesign installer will install MathMagic Pro application in the 

Applications folder on the root directory, MathMagic Plug-in in the Adobe InDesign's Plug-ins folder, 

otherwise specified. MathMagic fonts in TrueType format are also installed in the ~/Libraries/Fonts 

directory. Documents and others will be installed in MathMagic Pro Edition folder.

Please make sure that you already have an Adobe InDesign installed in your hard disk so the 

MathMagic Pro installer can find the Plug-ins folder automatically. If Adobe InDesign is not installed 

prior to MathMagic Pro installation, the installer will just copy MathMagic Plug-in in the MathMagic 

Pro Edition folder. You can then copy the MathMagic Plug-in in the Plug-ins folder later manually to 

the following location on Mac OS X. 

:Applications:Adobe InDesign:Plug-ins:Equations:MathMagic.pln

On the other hand, the MathMagic Pro for QuarkXPress installer will install MathMagic XTension 

in the XTension folder located in the same folder of QuarkXPress application that you want to install 
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to. The other components are same with MathMagic Pro Edition for Adobe InDesign.

:Applications:QuarkXPress:XTension:MathMagic XTension for 6

8.2 Creating Equations

There are four ways to create an equation inside Adobe InDesign or QuarkXPress document.

In QuarkXPress,

 - By choosing MathMagic menu from the main menu bar -> New Equation menu item, 

 - Sigma tool( ) from the main toolbar, 

 - control-clicked contextual menu(or, right button click of multi-button mouse), or

 - importing an Equation EPS file exported from MathMagic application, using File -> Get Picture 

menu after selecting a picture box rectangle.

In Adobe InDesign,

 - By choosing Plug-ins menu -> MathMagic -> New Equation menu item, 

 - Sigma tool( ) from the main toolbar, 

 - control-clicked contextual menu(or, right button click of multi-button mouse), or

 - importing an Equation EPS file exported from MathMagic application, using InDesign's File -> 

Place menu.

Please follow the following steps to create an equation in the InDesign document.

• Launch Adobe InDesign application(v2.0.1 or higher is recommended).
• Make a  new InDesign document or open a document.
• Select the Plug-ins menu -> MathMagic sub-menu.
• Choose "New Equation" item to create an equation. 

If the cursor is located in the text box, the equation will be inserted in the cursor 
position as an In-line Graphic(ILG). Otherwise, the equation will be placed as an EPS 
graphic on where you click the mouse. 
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You can find the QuarkXPress working environment is very similar to that of InDesign as 
shown below.

 

• You may select the Sigma tool ( )button from the floating main toolbar to create an 

equation box, and then drag a rectangle in the document to specify the location of an 
equation once created by the external MathMagic Pro.

• You may also control-click(or right button click of multi-button mouse) to bring up 

the contextual menu while the cursor is in the text box, so that you can choose the "New 
Equation" from the contextual menu. If there is an equation selected, the contextual menu 
will enable "Edit Equation" item as shown below for InDesign and QuarkXPress.
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• If you either select "New Equation" menu or drag a rectangle with the Sigma tool, 
MathMagic Pro application will be launched, if not running already, and an empty 
equation editor window will be opened. In case MathMagic Pro application is not launched 
automatically within a few seconds or older version or Personal Edition is launched, 
please launch the latest MathMagic Pro application manually from the following location.

    :Applications:MathMagic Pro Edition:MathMagic Pro

Or, you can specify the location of the latest MathMagic Pro application in the Preference 
window, so that the MathMagic Plug-in can launch the specified one correctly.

• Enter any equation in the MathMagic editor window, and then Close(cmd-W) or 
Save(cmd-S) the window. This will send the equation back to the InDesign document.

• You may also make equations with MathMagic Pro application and save them in EPS 
format thru File->Export->EPS menu. Then, you can import those EPS equations and 
Place them inside InDesign document, or Get Picture  into a box in QuarkXPress 
document.

8.3 Editing Equations

There are a few ways that you can edit an equation after you create it.

• Choose "Edit Equation..." item to edit the currently selected equation. Or, just double-
click on the equation box(InDesign only. QuarkXPress does not support.), while pressing 
command-option-key if the Arrow tool is not selected at the moment, to open it with 
the external MathMagic Pro application for editing. You may also control-click on the 

equation to bring up the contextual menu, after changing the cursor to the Arrow tool.
• After creating or editing an equation with the external MathMagic Pro, just close the 

equation editor window so that the equation is send back to and placed in the InDesign or 
QuarkXPress document.

• The baseline of all equations will be automatically adjusted. But if you want to lower or 
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raise the baseline, you may do so.
- just change the cursor to the arrow cursor and move the equation box by dragging to 
where you desire, or
- control-click on the equation box to bring up the contextual menu, and then select 
"Shift Baseline" item, or
- select an equation box and choose "Shift Baseline..." menu item from the MathMagic 
menu

8.4 Managing Equations

Each equation object, created with MathMagic Plug-in or XTension and MathMagic Pro application, is 

saved in EPS format. And it is saved in a directory in the same location to the current document. The 

directory is named like documentName.eqdb
All the equations will be managed by Adobe InDesign or QuarkXPress application automatically. But 

when you copy the InDesign document or QuarkXPress document file that contains equations, you 

may also want to copy the .eqdb folder as well so the document can later load the original equation 

objects correctly.

If the links to EPS equation files are lost for some reasons, you may want to update the links from the 

'Link' floating window invoked by InDesign's Windows  -> Link menu, as shown below.

If you want to send the InDesign document to a printing service bureau, you may want to make a 

Package by choosing File->Package... menu, so it will find and combine all equation EPS files together 
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with the document. Please also make sure to bring all MathMagic TrueType & Postscript fonts as well.

If you want to send the QuarkXPress document to a printing service bureau, you may want to collect 

all components by choosing File->Collect for Output... menu, so it will find and combine all equation 

EPS files and MathMagic fonts together with the document. Please make sure to bring MathMagic 

fonts too.

You can share the work with Windows users. When you copy and send InDesign document, you can 

also copy the .eqdb folder together to Windows user. On Windows, you may need to update the Link 

to each equation from Windows -> Link menu, if not recognized automatically. 

When you want to use Windows Equation files on Mac OS X, you may need to specify the file type if 

the Equation EPS file is not recognized by Mac version of MathMagic.
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IV. Template palettes and Symbol palettes

1. Template palettes

Templates are a series of collections of mathematical symbols and empty slots

such as .

By simply selecting templates and entering appropriate

characters in each slot, you build equations.

You can create expressions by filling symbols or characters into the space given

by the mathematical symbols. Below is an example of summation template.

Empty slots

Here are all template popup menus and you will learn them one by one.

 

Fences

Fractions

Radicals

Subscripts and Superscripts

Underscripts and Overscripts

Summations

Integrals

Product and Set Theory

Phantom

Spaces

Alignment

Variables with Primes, ...

Lines

Frame

Matrix

Labeled Arrows

ArrowsBars, Arcs, Braces, and Brackets  

Each of the template palettes will be shown in this section.
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1.1 Fences

These templates provide you with various ways of enclosing expressions 

between matching pair of symbol, which are called fences or delimiters in 

typesetting jargon. Though you can type (), {} or [] on your keyboard, 

these can't be adjusted along with their size. The differences between 

equations created using fence templates and one using bracket characters 

on keyboard are as follows.

[
x2-1
3 ]:The bracket are characters typed in by keyboard.

x2-1
3; E:The bracket is a Fence template.

1.2 Fractions

This palette provides templates for creating fraction layouts including 

diagonal fraction, slash fraction, vertical fraction as well as divisions. 

 icon and  icon are used for creating full-size fraction and 

reduced-size fraction respectively. In a reduced-size fraction the 

numerator and denominator are normally in subscript size and are placed 

closer to the fraction bar. You can customize the spacing for fractions 

from the Spacing tab of Preferences window.

x
y

x
y week

day
x x3-2x+7

x3-2x

7

x2-2g

1.3 Radicals

This palette provides templates for creating radicals and long division 

layouts. The amount of space between radicals and their contents can be 

controlled from the Spacing tab of Preferences window. 

You can also align a series of radicals using Root Alignment command in 

the Format menu. This command is activated when a radical sign has been 

created and the cursor is located next to or in it. 
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1.4 Superscripts and Subscripts

This palette provides templates for creating subscripts and superscripts. 

Note that these templates don't create slots for the expression to which the 

subscript or superscript is being attached. 

This is normally to add subscripts and superscripts to one character or 

symbol. If it is necessary to add a subscripts or superscript to multiple 

characters, symbols, or another templates, you may use the following 

template - Underscript and Overscript, which also gives you a main slot.

1.5 Underscripts and Overscripts

This palette provides templates for creating subscripts and superscripts. 

Note that these templates do create slot to which the subscript or 

superscript is being attached.

This is normally to add subscripts and superscripts to the whole slot. If it 

is necessary to add a subscript or superscript to one character or symbol, 

you may use the above template - Superscript and Subscript, which does 

not create a main slot.

1.6 Summations

You can create various types of sums with these templates. 

You can also create repeated sums by repeated usage of single summation 

template.

aij bjkcki , ars
1 # r #3

1 # s# n

!
k

!
j

!
i

!  

1.7 Integrals

There are thirty integral templates in all, including single integrals, line 

integrals, double integrals and triple integrals, all with various 

combinations of integrals.

If you need to insert variable height integrals that grow multiple rows, 

you can press shift key while clicking on any integral button.

Dx
0

3

# Dx
0

n

#   
ax

by

cz

)  
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1.8 Products and Set - Theory

These templates are used to create products, coproducts, and set-theoretic 

intersections and unions.

1.9 Bars, Arcs, Braces and Brackets

These templates are used to create expressions that have bars, arcs, braces 

or brackets either under them or over them. The last two items, angled 

hats, do not grow while the slot expands.

You may also apply multiple hats and bars by selecting those templates 

continuously.

asdfasdf

sumH
ABC
(

asdfasdf
: <;;;;

ABC
&

ABC
abc
Y(

D

1.10 Arrows

These templates are used for creating expressions that have arrows either 

under them or over them. 

The length of arrow will be automatically grow while the width of slot 

grows. You may also have arrows on both sides of the slot by selecting 

arrows twice.

ABC ABC ABC

1.11 Labeled Arrows

These templates can be used to describe convergence to a limit or some 

property of a function. See below for example.

fn(x) uniformly f (x), f:X onto Y
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1.12 Matrix

You can build column vectors, determinants, matrices and other tabular 

layouts using these matrix templates. The bottom-end templates represent 

variable-size matrices or tables, that bring up a dialog box for matrix 

configuration. The dialog box allows you to specify the number of rows 

and columns in your matrix, and how they are aligned. See below.

Matrix setting dialog also lets you specify lines between rows or columns. 

You can just click the mouse and drag where you want to set lines. Just 

click again on the line if you want to disable it. 

This feature can be applied for many other formatting needs. For example,

#

3

3

3
1

6

2

8

2
2

4

4

  (MMTextBook font is used.)

 

The spacing of entries in a row, the spacing between rows, line width and 

others can be controlled using the Spacing tab of Preferences window. 

Align Left / Center / Right and Align Top / Baseline / Bottom can be 

applied to the Matrix columns and rows from the Format menu.
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1.13 Frames

You can frame a box in a few different styles including fully framed 

square. 

The thickness of the frame and the gap between frame and slot can be 

adjusted in the Spacing tab of Preferences window.

You can also adjust the width of an empty frame box by typing in space 

characters. 

You may use Phantom template to fix the 

height of the frame box regardless of the 

character height you type in.

1.14 Lines & Negates

When you need to put a horizontal line, X line, slash, back slash on a 

character or on a whole box, you can use these templates. 

The upper line is for a character and the 

lower line is for a box.

You can specify the thickness of line and 

overhang gap between box edge and line-

end in the Spacing tab of Preferences.

1.15 Variables with Primes, Hats, Bars

Mathematical variables often have primes, hats, bars, and dots attached to 

them. These are known as diacriticals or accents. These templates will be 

attached to the character to the left of the insertion point. It is possible to 

attach them several times if you need to apply more than one.

The order in which these templates are applied may affect their 

positioning.  Selecting  icon will remove all the applied templates 

from the character.  delete key will remove one by one.

opqa o la srla

The prime height and minimum gap between base character and attached 
ones can be adjusted in the Spacing tab of Preferences window. 

1.16 Alignment

This template is used to align a set of equations easily.

See below to learn what this can do in your expressions.
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y= x2-1

y2-1=x3+3x2-5x

You can align these two line equations by adding Alignment template 

before each before each equal sign(=). If you have multiple lines that you 

want to align them to a certain position, please move the insertion point to 

each line and insert the Alignment template each.  Then, it will look like 

the second box, aligned to the beginning of equal sign.

Lastly, you can move "y" character to the right side by adding a series of 
spaces. You may enter wide spaces and narrow spaces from the Space 
template below to sharply adjust the movement.
Its shortcut key is available as command-option-Tab key.

1.17 Spaces
This palette contains spacing templates that don't have any slots. Each 

template adds a space with its own width : 1/8, 1/6, 1/4, 1/3, 1/2 and full 

width of Em space. 1/8, 1/6, 1/4, 1/3, 1/2 and full width of the current base 

text size(for example, 12point).zero-point which removes the default 

width between two math notations. 1-point, space-character width. 

You can use these spaces to adjust character and template gaps, 

alignments, and so on, as a supplement of Alignment template.

This control character showing the space width  is non-printable character 

and can be hidden or shown by Hide/Show Control(command-Y) under 

View menu.

1.18 Phantom (Strut bar)
This template is used to maintain the height or width of the 

current slot for some reasons.  For example, you can keep the 

box frame's height same by adding strut bar mark in each 

slot, regardless of the content characters. 

Ascent only strut bar and Decent only strut bar are available as well. Full 

size width can also be maintained by using horizontal strut bar including 

left, center, and right alignment options.

This control character  is non-printable character and can be hidden or 

shown by Hide/Show Control(command-Y) under View menu.
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2. Symbol palettes

Here are all template popup menus and you will learn them one by one.

   

Greek characters

Arrows

Set Theory

Relational Symbols 

Logical Symbols & Elipses SymbolsTriangles & Angles

Relational Symbols 

Operators 

Miscellaneous Symbols 

Shape Symbols

  

2.1 Greek Characters
These two palettes contain icons for the entire Greek alphabets, both 

upper-cases and lower-cases.

There are two different Greek fonts available by default in the 

MathMagic installer: MMGreek and MMCenturyOldGreek fonts. You 

can specify the default Greek font in the Style tab of Preferences 

window. Or you can just change the font from the Font menu after you 

enter a Greek character.

Please note that  the Plain style of these Greek fonts are intentionally 

designed as Italic style so that you do not need to apply Italic face in 

general.

ABVDEUCKOPHXWab|dcmriv  MMGreek

ABVDEUCKOPHXWab|dcmriv  MMCenturyOldGreek

Some of the symbols are assigned with shortcut keys. For the shortcut key 

table, please refer to the Appendix or Advanced Features chapters.
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2.2 Arrows

This palette contains buttons for various arrow symbols. 

You can find more arrow symbols that are not listed here in MMArrow 

font

You may compose any type of negated symbols by applying 

1.14 Lines template to the symbols.

\!Y&[DY2YU

Some of the symbols are assigned with shortcut keys. For the shortcut key 

table, please refer to the Appendix or Advanced Features chapters.

2.3 Set Theory

In this palette, there are symbols related to Set theory and Negation Set 

theory symbols.

Or, you may compose any type of negated symbols by applying 

1.14 Lines & Negations template to the symbols.

!Y!"Y"Yn,

Some of the symbols are assigned with shortcut keys. For the shortcut 

key table, please refer to the Appendix or Advanced Features chapters.
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2.4 Relational Symbols

These palettes contain symbols that express various 

relationships between two quantities, most of which 

involve some notions of equality, inequality, or 

equivalence. 

You may compose any type of negated symbols by 

applying 1.14 Lines template to the symbols, if there 

is no corresponding negation symbol found in the 

negation symbol palette or in the MMNegate or 

MMRelation font.

Y#YFYP[fYk\,Y/

Some of the symbols are assigned with shortcut keys. 

For the shortcut key table, please refer to the 

Appendix or Advanced Features chapters.

2.5 Triangles and Angles

This palette provides triangle symbols for representing normal subgroup 

relationships as well as a few angle symbols.

 

You may compose any type of negated symbols by applying 

1.14 Lines template to the symbols.

2.6 Logical Symbols and Ellipses Symbols

There are horizontal, vertical and diagonal row of dots in this palette.

Normally, an ellipsis is a row of three dots indicating that items have been 

left out, usually because they are obvious from the context. 
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2.7 Operators and Extended Operators

This palette contains symbols representing mathematical operators of 

various types.  Some of circled or boxed symbols are available in the next 

palette.

Some of the symbols are assigned with shortcut keys. For the shortcut key 

table, please refer to the Appendix or Advanced Features chapters.

2.8 Miscellaneous Symbols

This palette contains various symbols that are either somewhat obscure or 

do not seem to fit in elsewhere. 

Some of the symbols are assigned with shortcut keys. For the shortcut key 

table, please refer to the Appendix or Advanced Features chapters.

2.9 Shape Symbols

This palette contains various symbols that have frequently used shapes. 

Bottom half with 'L' mark on the left bottom corner is 'Large' pair of the 

upper half.
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2.10 Other Symbols

There are many other symbol fonts available in MathMagic fonts which are not located in the Symbol 

palettes. You can view them with your favorite Font management utility like SuitCase™ or Font Reserve™ 

or KeyCaps™ utility.

You may also use other fonts than MathMagic fonts, like Symbol or Zapf Dingbats by selecting it from Font 

menu after you enter a character or string in the MathMagic editor window.
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V. Tutorials

This part contains several tutorial examples of using MathMagic. We provide step-by-step instructions 

for each example to make you easy to work with MathMagic.

The characters you have to type will be shown in bold type.

Do not worry about making mistakes. If you type something wrong, or insert some wrong symbol or 

template, you can correct it by command-Z for Undo, or by pressing the BACKSPACE key.

1. Fractions and Square Roots

In our first tutorial, we will create the equation

x=2y!
8

sinx +c2
 

To create this equation, just follow below steps. 

Do not forget that you have to type into the equation the bold characters. 

Please note that the surrounding rectangle frame is just for decoration purpose only, even 
though it can be entered easily in MathMagic.

1. In the document window, type x=2y without space between characters.

You can see that only x and y has been made italic. It happens automatically because Mathematical 

variables are almost always printed in italics, so this is the default in MathMagic.

2. Next, to insert the ± symbol, open the Symbol toolbar’s  palette(the 2nd) and click the ± 

symbol on the palette.

3. Now to insert a square root, open the Template toolbar’s  palette(the 3rd) and click the 1st 

square root template, or command-R for the shortcut key. The insertion point will be located 

inside the root slot. Now your equation should look like this:
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4. Next we need to enter a fraction template. To do this, open the Template toolbar’s  palette and 

click the 1st fraction template, or command-F for the shortcut key. Now your equation should 

look like this:

5. To enter the denominator of the fraction, just type sinx.

Please note that the current version of MathMagic has the oriental input order by default. 
So the cursor will position in the denominator slot first.

6. To enter the numerator of the fraction, we need to move the insertion point from denominator to 

numerator. To do this, you can press the TAB key or click inside the numerator slot, or press the 

down arrow key. Then, just type 8. 

7. Next we need to insert the + symbol outside of the square root sign. To do this we have to move 

the insertion point to the correct position. Press TAB key repeatedly until it goes to the outside of 

the square root sign. By this action you can see how insertion point cycles through all the slots. If 

you hold down the SHIFT key while you do this action, the insertion point will cycle through the 

slots in the reverse direction.

8. Once we moved the insertion point to the outside of the square root, we just type +c. 

9. To attach the superscript to the c, open Template toolbar’s  palette and click the superscript 

template or simply just click Main toolbar’s  superscript icon, or command-shift-H (cmd-H 

on OS 9) for its shortcut key.

10. Type 2 into the superscript slot. Finally, the equation will look like this:

11. If you want to add this equation as a clip, select the equation and then execute the Make a Clip 

command under the Edit Menu. The added equation clip will be shown at Clips window with the 

default name of Window title, followed by a sequential number.
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12. To save this document, use the Save command on the File menu or press command-S which is 

the shortcut key of this command.

2. Subscripts and Superscripts

In this tutorial we’ll create an equation, which contains subscripts, superscripts, braces and summation 

templates. 

We’ll create the formula of the complex Fourier series, which is: 

f (x) = cne
inx

n=-3

3

!

1. In the document window, type f.

2. Now, you have two choices to enter the brace.

In this case, you may just want to enter (x) from the keyboard as characters. 

If you want the brace work more specially with automatic formatting feature, you need to insert it 

thru the Template. To insert a pair of braces (curly brackets), open the Template toolbar’s  

palette and click the 1st curly bracket template. Type x into the braces. The insertion point will be 

automatically located inside the braces’ empty slot when the braces are inserted. 

Next, if you used braces Template, we need to type = outside of the braces. To do this, we have to 

move the insertion point to the outside by pressing TAB key or just by clicking the correct 

position.

3. Once we moved the insertion point, we just type =. 

4. To insert the summation template, open the Template toolbar’s  palette and click the  

template. Or, command-T, and then S for the 2 step shortcut. Command-T means that Template 

shortcut starts.

Now the equation should look like this:
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5. Type the letter c into the summand slot (the large slot on the right).

6. Attach a subscript to the c, using the Main toolbar’s  icon, or command-L for its shortcut. 

Fill in the subscript slot with n.

7. Press tab key and move the cursor to the next slot. Type the letter e.

8. Attach a superscript to the e, using the Main toolbar’s  icon, or command-shift-H. 

Fill in the superscript slot with inx. The equation should look like this: 

9. Now, press Tab key to move to the next slot, or click inside the lower limit slot of the summation 

template to move the insertion point inside the slot, and type n=-. To insert the 3 symbol, open the 

Symbol toolbar’s  palette and click the infinite symbol.

12. Now, click inside the upper limit slot of the summation template, and insert the infinite symbol as 

we did in the previous step.

Finally, the equation should look like this: 

3. Matrix
In this tutorial we’ll create the equation 

W (y1, y2) =
y1
ly 1

y2
ly 2

1. First of all, type W in the document window.

2. Next, to insert a pair of braces (curly brackets), just type ( ) from the keyboard, or open the 

Template toolbar’s  palette and click the curly brackets template. There is  slight different 

behavior between these. You may choose your preferred style after trying both.

3. Type y into the braces.
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4. Then attach a subscript to the y, using the Main toolbar’s   icon or command-L. Fill in the 

subscript slot with 1. Press tab key to move the cursor to the next slot.

5. Type , y beside y
1
. Now we repeat the step 4 with this y. This time we fill in the subscript slot with 

2. Now the equation should look like this:

6. Now we need to type = outside of the braces. To do this, we have to move the insertion point to the 

outside by pressing TAB key or just by clicking the correct position.

7. To insert the  side bars, open the Template toolbar’s  palette and click on  button. Now the 

equation will look like this:

8. To insert the matrix template, open the Template toolbar’s  palette and click a 2 x 2 matrix 

template. Now the equation will look like this:

9. The insertion point will be in the top left slot of the 2x2 matrix, so type y there, and then attach the 

subscript 1. To attach a subscript, you may repeat step 4.

10. To save time, we may just create the other entries in the matrix by copying and pasting. Select the 

y1 by double-clicking on it, copy it to the Clipboard, and paste it into the other three slots in the 

matrix. We can use TAB key to move from a slot to the other. Now we have the equation shown 

below, but we’ve to fix it up because it’s not the one we’re trying to create.

11. Now, we need to correct the entries in our matrix. First, change the subscripts of the upper right 

and lower right slot to 2. Now the equation will look like this:

12. The lower slots should contain the prime template between y and the subscript. To insert this, 
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move the insertion point before the subscript, open the Template toolbar’s   palette and click the 

prime template. Apply this step to all the lower slots. Finally, the equation will look like this:

By now, you should be able to create any imaginable equations.

4. Editing Equations

In this tutorial we’ll learn some special editing techniques that are useful to modify an existing 

equation. These techniques will save your work time.

When you need to correct a mistake in an old equation, or make a new one that is a slight variation of 

the old one, it would be better to bring a copy of the old equation and then modify it as needed instead 

of starting from scratch.

Frequently used equations can be saved as Clips by pressing command-M or by using the Make a 

Clip command under the Edit menu, or by dragging & dropping the equation into the Clips window. 

Remember that before you save as Clip by shortcut key, the equation must be selected. All saved clips 

will be listed in the Clips window. 

These Clips window’s equation clips can be inserted back to the document by double-clicking or 

drag&drop to the document.

Now, let’s work with the equation we made in Tutorial 1 x=2y! 8
sinx +c2

. 

We’ll create equation shown below modifying the old one:

y0=2y! 2r
8

sin x

+c2

1. First, open the document containing the equation you created in Tutorial 1 above. 

If you’ve added the equation as a clip before, you can bring it just by double-clicking on a clip 

from the Clips window instead of opening the old document.

2. After we have the equation, we need to change the term on the left, x to y. To do this, select the x 

by double-clicking. Now the x will be highlighted, and the equation will look like this:
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3. To change x to y0, delete the selected item by using the Clear command on the Edit menu or by 

pressing the 'delete' key. Now the insertion point will be in the left of the = sign, so you can now 

type y and attach the subscript 0 to it by using command-L for the subscript template shortcut.

Note: You can type y immediately after selecting the x, without the deleting action. It will give 
you the same result.

4. Now, we need to insert the fraction template. Move the insertion point to the right of the ± symbol. 

Open the Template toolbar’s palette and click the fraction template. The equation should look like 

this:

5. Next, we’ll insert the root part inside the numerator slot of the fraction template. To do this, select 

all the root part of the equation and execute the Cut command on the Edit menu. Then, click into 

the numerator slot of the fraction and execute the Paste command on the Edit menu. The shortcut 

keys of these commands are command-X (Cut command) and command-V (Paste command). 

Now the equation will look like this:

6. To insert the root template into the denominator, move the insertion point inside the denominator 

slot of the fraction and then insert the root template by using command-R shortcut key, or  

button in the usual way.

7. Now, type 2 into the root slot. And then, to insert the  symbol, open the Symbol toolbar's  

palette and click the  symbol. Finally, the equation will look like this:
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5. Fonts and Styles

In this tutorial we’ll learn how to change the fonts in the equations by changing Style definitions. 

Using the Style feature you can achieve your specific formatting quickly and easily. In this tutorial 

we’ll work with this equation:

 

1. Create the above equation, inserting the a symbol by choosing it from the Symbol toolbar’s  

palette.  And the rest  s=, (x+y) and -log2 can be just typed like regular characters. 

The equation will look like this:

2. Now, to bring the Style setting pane, choose Style tab from the Preferences menu or simply click 

the Main toolbar’s  icon and choose the Style tab. 

The dialog shown below will be displayed.

3. The names of the styles are listed together with the font and character style (bold, italic) assigned 

to each. The equation we have just created uses Function, Variable, L.C. Greek, and Number 

styles. The Function style is automatically assigned to the letters “log”, because log is the standard 

abbreviation of the logarithm function. The s, x and y are treated as variables and assigned the 

Variable style. The a being lowercase Greek letter, uses the L.C. Greek style and the number uses 

the Number style.  The brackets and =(Equal) do not use a style.

4. Now, we are going to change some of the styles so you understand how they affect an equation’s 
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appearance. Let’s change the font of the Function style. To do this, press on the arrow next to the 

font name in the Function row and choose a different font. We’ll choose the Gadget font, which 

will look noticeably different from MMTimes.

5. Click OK button for confirmation. The equation will be redisplayed using the new Function style. 

The logarithm function ‘log’ will be displayed using the new font. 

The equation should look like this:

6. Next, we’ll change the font of the Variable style. This style will be assigned to the s, x and y. Let’s 

choose the same font assigned to the Function style. You may check that the italic character style is 

checked for Variable, but not for Function style.

7. Click the Preview button. The equation will be redisplayed using the new Variable style without 

closing the dialog box. Preview button shows you immediately the changed equation without 

closing the dialog and it can be ignored if you close the dialog with "Cancel" button The equation 

will now look like this:

8. Now, let’s also change the font of the L.C. Greek to "Symbol" and Number style to "Geneva" so 

that it uses the font you like. Each style will be assigned to a and to the number 2 each. 
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Click the Preview or the OK button. Now, the equation should look like this:

9. To reset the style definitions changed by our testing, click the Factory Settings button. 

10. You can now change the font and style as we did in the above steps. 

Now, change them to make the equation your own.

[NOTE] You may also change the Font, Size and Style via the Font menu, Size menu and Style menu directly 

for the selection in the document, if you just want to change it once without applying the specified 

Font/Size/Style for the entire document.

For details on fonts, styles, sizes and spacing, refer to "Advanced Features" in Chapter VI.

6. Applying and Changing Colors

In this part you will learn how to apply colors to various part of templates and symbol, and how to 

change a color to other color after you apply.

MathMagic allows you to specify colors freely just like other word processors - applying while 

typing-in equations, and applying colors later after you type in all equations in black.

Let's start with a simple color equation.

   - Contains two colors in two different blocks.
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1. First enter all your equations in black.

2. Secondly, create your preferred Color styles in either Document Color list or Application Color 

list, by choosing "New Color" button from the Color window. Creating all color styles at one is 

fine: Blue and Red.

3. Select 'y', and then apply Blue color, by choosing from Color menu or double-clicking on the Blue 

color 

4. Select 'x2', and then apply Red color, by choosing from Color menu or double-clicking on the Red 

color 

Let's try again with an equation with templates.

  - Contains a blue fraction bar, red root template, green text and black 
 numerator text, and a blue integral.

1. First enter all your equations in black, and create your preferred Color styles: red, blue, green. 

These three basic colors are available in Application Color list on the Color window, so you can 

just use those colors by double-clicking on each of them.

2. Select all and apply Blue color.

3. Select root part only and apply Red color.

4. Select '25', and then apply Green color. Select '3', and then apply Black which is a Normal Text.

With this step by step applying of color to selected area, you can set a color on any particular part 

of equation, even on a specific portion of a template.
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Let's change color quick.

   - Change all blue color components to purple color.

1. Open the document window that contains the equation front-most 

2. Open Color floating window if it is not open. And click on the Document Color list to make the list 

active.

3. Select the Blue color from the Document color list, and press the "ReAssign" button.

4. Choose a new color your want from the Color Picker. Or, Purple for our testing. And the press 

"OK".

4. Enter a new color name if you also want to change the color style name. Otherwise, you can just 

leave the name untouched. Press "OK". By the way, you can use your favorite Color picker 

interface by switching from above list.

      
5. You should see the changed color in the document window.

With this approach, the more color related work you have, the more time you will save
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VI. Advanced Features

1. Editing Keys

MathMagic supports commonly used editing keys in the equation editor window. Some keys 

are as followings.

Keyboard Behavior
right arrow Move cursor to the right

At the end of a template box, move to the beginning of the next box
left arrow Move cursor to the left

At the beginning of a box, move to the end of previous box
down arrow Move to the same point of the next line
up arrow Move to the same point of the previous line

cmd-right arrow Move to the end of the line
cmd-left arrow Move to the beginning of the line
cmd-down arrow Move to the end of the document
cmd-up arrow Move to the beginning of the document

shift-right arrow Move  cursor to the right, and select in-between contents
shift-left arrow Move cursor to the left, and select in-between contents
shift-down arrow Move to the same point of the next line, and select in-between contents
shift-up arrow Move to the same point of the previous line, and select in-between contents

home Move cursor to the begging of the current box or line
end Move cursor to the end of the current box or line
cmd-home Move cursor to the begging of the document
cmd-end Move cursor to the end of the document

shift-cmd-right arrow Move to the end of the line, and select in-between contents
shift-cmd-left arrow Move to the beginning of the line, and select in-between contents
shift-cmd-down arrow Move to the end of the document, and select in-between contents
shift-cmd-up arrow Move to the beginning of the document, and select in-between contents

tab Move cursor to the end of current box
At the end of a box, move to the beginning of the next box

shift-tab Move cursor to the beginning of current box
At the beginning of a box, move to the end of the previous box

return, enter Add a new line as a same level of current line
In the middle of a box, breaks the line and move the right part to the next line

delete (backward) Delete the left character of the cursor
If it is a template, select the box first and then delete it by another delete key

del  (forward delete) Delete the right-side character of the cursor
If it is a template box, just select the box
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2. Keyboard Shortcuts

Many templates and symbols are assigned with default keyboard shortcuts for fast input without 

moving your hand to mouse. 

When you select a template or symbol via keyboard, there are three kinds of predefined Keyboard 

shortcuts provided by MathMagic Pro and MathMagic Personal, and a user-definable Shortcut key 

set.

You can use any method all the time at your convenience.

2.1 Magic control key

This is MathMagic's unique shortcut key user interface for accessing any templates or symbols with visual 

navigation interface.

With this control key based live interface, you don't have to remember any shortcut allocations. 

Just press option key while an editor window is open, and then you will see the corresponding shortcut key 

in the yellow tooltip for all templates or symbols listed in the window.

Here, if you select any key you want to choose, it will then display the popup menu just like you clicked on 

the button. 

Now you can leave the option key unpressed once the popup menu is displayed, and then you will see the 

shortcut key mappings for each item of the popup menu.

If you type any key from the tool tip list, the item will be inserted into the current cursor location.

With this Magic control key interface, you can select any item in just two steps of key typings.

You can press control-tab or control-shift-tab to navigate to the next or previous popup menu.

You can press option-tab to switch between Template and Symbol tabs.

This interface is also available for User Item toolbar items, by pressing shift-option keys.

2.2 Direct command shortcut keys

Commonly used template items are assigned with direct shortcut keys for fast and convenient input. This is 

like other menu shortcut keys. 

For instance, you can press command-I for integral template, command-R for root template, and so on.
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Please refer to the following table for each key mapping.

2.3 Two-step command shortcut keys

Many commonly used template items, symbol items, and Greek symbols are assigned with two-step shortcut 

keys for fast and convenient input. 

You tell MathMagic by pressing command-T, command-K, or command-G that the next key typing is to 

be a shortcut key input for template items, symbol items, or Greek characters.

For instance, you can press command-T followed by S for sigma template item, command-K followed by 

A for arrow symbol, command-G followed by B for Beta symbol, and so on.

Please refer to the following tables for each key mapping supported by the current version of MathMagic.

Greek shortcut keys: Starts with command-G

All Greek characters can be easily typed via command-G  followed by alphabet keys, just line Roman characters.

Most of the Greek keys are allocated with its related Roman key corresponding.

Please refer to the following table for all Greek character shortcuts.

cmd-G, shift-A

cmd-G, shift-B

cmd-G, shift-C

cmd-G, shift-D

cmd-G, shift-E

cmd-G, shift-F

cmd-G, shift-G

cmd-G, shift-H

cmd-G, shift-I

cmd-G, shift-K

cmd-G, shift-L

cmd-G, shift-M

cmd-G, shift-N

cmd-G, shift-O

cmd-G, shift-P

cmd-G, shift-Q

cmd-G, shift-R

cmd-G, shift-S

cmd-G, shift-T

cmd-G, shift-U

cmd-G, shift-W

cmd-G, shift-X

cmd-G, shift-Y

cmd-G, shift-Z

cmd-G, A

cmd-G, B

cmd-G, C

cmd-G, D

cmd-G, E

cmd-G, F

cmd-G, G

cmd-G, H

cmd-G, I

cmd-G, K

cmd-G, L

cmd-G, M

cmd-G, N

cmd-G, O

cmd-G, P

cmd-G, Q

cmd-G, R

cmd-G, S

cmd-G, T

cmd-G, U υϖ

cmd-G, W

cmd-G, X

cmd-G, Y

cmd-G, Z

cmd-G, J cmd-G, Vcmd-G, shift-J cmd-G, shift-V

. 
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Template shortcut keys: Starts with command-T

Some commonly used Templates are assigned by its own command key, like command-F for Fraction. 

More Templates are assigned by command-T based shortcut key, followed by its own unique key. Like 

command-T, followed by 'F', for .

Please refer to the following table for Template item shortcuts.

cmd-9  or  cmd-0
cmd-T, 9 or 0

cmd-shift-9 or cmd-shift-0
cmd-T, shift-9 or shift-0 

cmd-[  or  cmd-]
cmd-T, [ or ]  

cmd-shift-[ or cmd-shift-]
cmd-T, shift-[ or shift-]

cmd-T, \

cmd-T, shift-\

cmd-F
cmd-T, F

cmd-shift-F
cmd-T, shift-F

cmd-capsLock-F
cmd-T, capsLock-F

cmd-T, D

cmd-T, shift-D

cmd-R
cmd-T, R

cmd-shift-R
cmd-T, shift-R

cmd-H or 
cmd-shift-H (OS X)
cmd-T, H

cmd-L
cmd-T, L

cmd-J 
cmd-T, J

cmd-T, U

cmd-T, shift-U

cmd-T, S

cmd-T, shift-S

cmd-T, capsLock-S

cmd-I
cmd-T, I

cmd-T, shift-I

cmd-capsLock-I
cmd-T, capsLock-I

cmd-T, P

cmd-T, shift-P

cmd-T, capsLock-P

cmd-T, N

cmd-T, shift-N

cmd-T, capsLock-N

cmd-T, M

cmd-shift-M
cmd-T, shift-M

cmd-capsLock-M
cmd-T, capsLock-M

cmd-B
cmd-T, B

cmd-/
cmd-T, /

cmd-shift-/
cmd-T, shift-/

cmd-capsLock-/
cmd-T, capsLock-/

cmd- - 
cmd-T, -

cmd-shift- - 
cmd-T, shift- -

cmd-capsLock- - 
cmd-T, capsLock- -

cmd- `
cmd-T, `

cmd- ~  or cmd-shift- `
cmd-T, ~ or shift- `

cmd-capsLock- `
cmd-T, capsLock- `

cmd- ' 
cmd-T, '

cmd- "  or cmd-shift-'
cmd-T, " or shift-'

cmd-capsLock- '
cmd-T, capsLock- '

cmd-T, .

cmd-T, shift- .

cmd-T, capsLock- .

cmd-T, A

cmd-T, shift-A

cmd-option-Tab
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Symbol shortcut keys: Starts with command-K

Many commonly used Symbols are assigned by command-K based shortcut key, followed by its own unique key. 

Like command-K, and then followed by 'E', for .

Please refer to the following table for Symbol item shortcuts.

cmd-K, C

cmd-K, shift-C

cmd-K, E

cmd-K, shift-E

cmd-K, U

cmd-K, shift-U

cmd-K, <

cmd-K, >

cmd-K, shift-<

cmd-K, shift->

cmd-K, =

cmd-K, shift- =

cmd-K, -

cmd-K, shift- -

cmd-K, T

cmd-K, shift-T

cmd-K, S

cmd-K, shift-S

cmd-K, A

cmd-K, shift-A

cmd-K, D

cmd-K, shift-D

cmd-K, O

cmd-K, shift-O

cmd-K, I

cmd-K, shift-I

2.4 Custom defined Shortcut keys: For User items and Clips

Also, any additions to the User Items Toolbar or Clips window can be assigned with their own hot keys.  

"Register Shortcuts..." item in the Edit menu will be enabled if there are any clips in the Clips window, or 

any templates or symbols in the User Items toolbar.

Choose "Register Shortcuts..." in Edit menu after adding any template or symbol into the User Items toolbar 
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or clip into the Clips window. Then, a dialog window will be displayed for assigning shortcuts.

[Customizing shortcuts for clips or user items]

Shortcuts can be configured using combination of COMMAND, CONTROL, SHIFT, OPTION, numbers 

and alphabet. If the configured hot key conflicts with the current one, the following dialogue will be 

displayed.

3. Customizing Styles

Choosing "Style" tab from the Preferences menu or clicking on the above icon in the main tool bar 

will bring the following dialogue box.
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Each entry in the left column indicates the types of expressions and can be configured with custom 

fonts and styles. The selected font and style is stored in MathMagic Pref file and will be applied to 

any subsequent inputs. If you change the font and style, and then click on the "Preview" button, the 

change will be applied to the editor window. And if you choose "Cancel" button, the change will not 

be applied.

[Note]
• "Math" item in the Style menu can be used when you want to recover the style back to its 

default state after changing font, size, or style.

 
After applying your own style - font, size, face

After reapplying the "Math" style

• When you type trigonometrical functions such as sin, cos, or tan, MathMagic will 
automatically change the style to the Function style. The Function style is displayed 
with plain text and wider char width. It is usually defined to be the MMTimes font.

• The Variable style is used for mathematical variables and constants of the equation. 
This Variable style is the default of the Math style. It is usually defined to be the 
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MMTimes font with italic character style. It is usually defined to be the MMTimes font 
with italic style.

• The Lower-Case Greek (L.C. Greek) style is used for lower-case Greek characters. It 
is usually defined to be the MMGreek font. It is usually defined to be the MMGreek font 

• The Upper-Case Greek (U.C. Greek) style is used for upper-case Greek characters. It 
is usually defined to be the MMGreek font. It is usually defined to be the MMGreek font.

• The Vector-Matrix style is used for characters representing vector or matrix 
quantities. It is usually defined to be the MMTimes font with bold character style.

• The Number style is used for numbers 0 to 9. It is usually defined to be the MMTimes 
font.

• The Text style is used for words, which are not mathematical functions. It is usually 
defined to be the Times font for English version.

4. Customizing Sizes

Choosing "Size" tab from the Preferences menu or clicking on the Preference button of Main toolbar 

will bring the following dialog box.

You may choose several units including percentage(%), point(pt), Que.(q), millimeter(mm) or inch 

for each field. Please note that the base field(Full size) won't recognize the percentage value since it's 
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the basis for other values. All the other fields can be configured relative to the "Full" size by 

specifying percentage unit.

• The Full size is used for ordinary characters. It is usually defined to be 12 pt. or the 
base text size of the text line that equation is inserted to.

• The Subscript size is used for subscripts or superscripts attached to Full size 
characters. Also used in limits in integrals, summations, and other templates.

• The Sub-Subscript size is used for subscripts or superscripts attached to Subscript 
size characters. Also used for any other place a second level of size reduction is required 
or for limit slots of templates inside the limits of other templates.

• The Symbol size is used for the oversize symbols in integral, summation, and product 
templates.

• The Sub-Symbol size is used for the oversize symbols in Subscript size slots.

5. Customizing Spacings

Choosing "Spacing" tab from Preferences menu or clicking on the Preference button in the main tool 

bar will bring the following window.
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Enter your preferred value for each field and click "Preview" button for previewing the result. If you 

click "Cancel", the changes will not be applied and the Preferences dialog window will be closed.

In most cases, the shape and placement of mathematical equations is varying according to the user's 

preference or its usage. MathMagic supports the highest accuracy up to three decimal digits for the 

shape or placement of any mathematical expressions. Also, it allows user to preview the change 

before applying. This will ease the configuration no matter how complex the math equations are.

In the Spacing tab of Preferences window, there are 14 setup items, and each of which has several 

fields for detailed configuration.

[Note]
You may use one of the following units for the configuration; %, pt, mm, inch and q. If you 
choose percentage (%), its value is the relative to the "Default" value in "Size" tab of the 
Preferences window.

6. Drag & Drop
Drag&Drop feature in MathMagic allows you to drag any selection into the desktop or other 

applications that support drag & drop. Also, you may add your preferred equation clip by dragging 

any selection into the Clips window. And by dragging selection into desktop, its picture clipping will 

be created. 

[Drag & Drop into the desktop]
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If you drag selection into other application, then it will be copied into the application window. 

[Drag & Drop into other applications]

Since MathMagic equation contains baseline information, standard word processors such as 

AppleWorks will align the copied mathematical expressions according to the baseline of body text.

If you want to re-edit those equation PICT dragged or copied into other application window later, 

you may copy the equation PICT and paste or drag it into MathMagic editor window. 

You may also copy and paste normal text into MathMagic editor window. But in this case, the only 

plain text will be inserted with MathMagic default styles applied, ignoring original style settings.

If you want remove any equation clip or user item, just drag it over the System trash icon. Also, you 

may remove them by Command-Clicking on buttons.

If you want to disable the confirmation dialog for each deleting, you may turn it OFF in the Misc. 

pane of Preference window.

  

For equation clips, you can just drag an item to the trash icon located in the Clips window as shown 
below, or click trash icon after you select one clip to remove it.
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 [Drag & Drop into the trash]

7. Variable-length Integrals
MathMagic supports variable length integrals that grow vertically depending on the rows to fit the 

whole length. This is normally for multiple rows of main slot. 

If you need to insert variable length integrals that grow multiple rows, you can press shift key while 

clicking on any integral button. or selecting from the integral template pop up menu.

 + while pressing shift key.

This feature works with all Integrals available in the Integral palette.

The following two examples show you how normal integrals and variable-length integrals act 

differently.
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8. Custom Matrix
MathMagic supports several customizable features for the Matrix.

n x n matrix can be specified by any of  buttons or command-T, M shortcut key, which 

bring up the Matrix Setting dialog. 

Here you can specify the number of rows and columns, alignment for rows and columns, lines 

between columns and/or rows.

The maximum number for column and row is 31. So you can create matrix from 1 x 1 to 31 x 31.

Please note that the number of rows or columns can not be changed once a matrix has been created. 

So you need to be careful about the dimension(column x row) before you create a matrix so that you 

don't have to reenter the contents of each slot when you change the number of row or column.

Each matrix slot can hold another matrix if you want for some reason.

The alignment for row and column can be changed later  thru the Align command under Format 

menu.  Align Left / Center / Right and Align Top / Base / Bottom under Format menu will be 

enabled when the current cursor is located within a Matrix. 

You can also set borders on each column and row of the matrix cells. This feature is especially useful 

when you need to create a simple table or multi row calculation forms, such as below.

a

b

c

x

3

1

2

y

5

6

8

z

7

4

3

sum

   

#

3

3

3

1

3

2

5

2

1

2

2  
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To set a border line, you can click and drag the mouse to set the length. If you click on the same line 

again, the border will be turned off.

  

The width of border line and overhang can be set in the Spacing tab of Preferences window.

9. Using Colors

This section covers some concepts in using colors within MathMagic and all the features of Color 

floating window and Color menu in detail.

You may quickly understand how to apply colors on templates and symbols if you read the tutorial:  

V. 6  Applying and changing colors.

 

Color Style

MathMagic supports colors with style in mind. So colors in MathMagic are supported with style 

concept. You can create some color styles for your project, and use those color styles in the 

documents though out the project together with a team. Each color style can have its name and 

specified RGB color. After you apply a color, created as a color style, to equations within a 

MathMagic document, you can later change the color of equation just by changing the color from the 

Color style list by Reassigning. So you don't need to go thru the document and reassign new colors 

one by one. If you are a heavy color users who use many color equations in a book editing or a big 

project, this feature will bring you a high productivity. 
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Application Color and Document Color

MathMagic supports two color set: Application Color and Document Color. 

Application Color is used MathMagic application wide, all over the documents. Application Color 

styles are listed in the Application Color List, located on the left side of the Color window. There are 

several factory settings for general colors. But you may delete them or add more. Application wide 

color styles are stored in the following location.

User Home:Documents:MathMagic User Data:Color:UserDefaultColor

So you may create a series of Color styles for your project, and share them with your team members 

to synchronize the color settings, by copying this UserDefaultColor file to those people.

Document Color is used by each MathMagic document so it is changed by document. Document 

Color styles are listed on the right side of the Color window. All colors used(stored) in a MathMagic 

document are listed in the Document Color List. Document Color styles are stored in each 

MathMagic document. So once you apply colors in a document and send the document file to other, 

they can also see the same styles in the Document Color List area when they open the document.

Using Color window

Most of the color management features, including the creation of a new color style, reassigning a 

color style name or its color value, deleting a color, assigning a color to an equation in a document, 

exchanging color styles between Application color list and Document color list, can be done within 

the Color floating window.

So if you understand each part and each components of the Color window, it will be easy to use 

colors within MathMagic. 

There are two lists in the Color window as shown below. Application Color List shows you all the 

registered colors that are used application wide. Document Color List shows you all the colors used in 

the topmost document window.

You can transfer Application color styles from Application Color List to Document color list by 

double-clicking on it, or pressing the right-arrow button after you select an application color. If it is 

already registered in the Document Color List, it will not be registered again. You can also transfer a 

document color style to the Application Color List by pressing the 'left arrow' after you select a color 

style that you want to use application wide.
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You can create a new color style by pressing 'New' button. In this case, it is important to select the 

right List box(either Application color list or Document color list) before you press the New button. 

New button will add a new color style to the currently selected list. You can select a list by clicking 

any place inside the list box and the selected one has the box frame of 3-point thick with system 

color. If you press New button, it will let you choose a color from the System's Color Picker. And the 

it will ask you to set the name of the color style as followings.

  

ReAssign button will also guide you to the same steps with New button, to choose a new color and to 

assign a new name for the currently selected color item.

Apply button will set the current Color style to the cursor location or the selected block of the current 

document. Applying color can be undone or redone by Undo/Redo command. You can also double-

click an item so that the color is applied to the document.

Delete button will delete the selected item from the current Color list box. But it will not be deleted if 

the color is used somewhere in the document. In this case, you need to first change the color to other 

color and then try to delete it.

Using Color menu
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Color menu is mainly for easier access to those Document Color List. You can create a new color 

style from the menu, and also apply a color to the current selected block or cursor position. But please 

note that it will always add the new color to the Document Color List regardless of the List box 

selection.

For the details of Color menu, please refer to the section: III. 2.8 Color menu.

Sharing Color styles with other people

If you are working with a team for editing a book or large document, you may need to set the same 

color values across the team.

In this case you can plan color usage for the project, and create those color styles from the Color 

floating window. Add all color styles in the Application Color List. Quit MathMagic. And then, copy 

the color style file from the following location, and send it to others who need to synchronize the 

color settings. They can then copy the file into the same location. And the launch MathMagic.

User Home:Documents:MathMagic User Data:Color:UserDefaultColor

Or you may create a sample MathMagic document which contains all the color styles in the 

Document Color List, and then send the document to others. They can open the sample document and 

add the document colors to Application Color List by pressing 'left-arrow' button from the Color 

window. 

Sharing and Exporting color equations

You can share the color equations just like black only equations by:

 - copy color equation and paste it into other software or another MathMagic document window

 - drag a color equation and drop it onto other applications; 

 - export color equation into PICT, JPEG, or EPS, as well as saving as MathMagic native document; 

 - registering color equations into the Clips window for future use.

You can export your color equation as PICT or JPEG format with MathMagic Personal Edition. 

MathMagic Personal Edition does not support exporting in Color EPS, while Pro Edition supports 

Color EPS as well. Personal Edition only supports Black EPS even though the original equation has 

colors.
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Exporting Color Equations in Color EPS and Black EPS

MathMagic Personal Edition does not support exporting color equation in Color EPS while Pro 

Edition supports.

"EPS Color" item from Export menu will be enabled or disabled depending on your MathMagic 

version.

Color Equations with MathMagic Pro

When you are using MathMagic Pro Edition with Adobe® InDesign™   together with MathMagic Plug-

in, you may want to send the created color equation back to InDesign document in both color EPS 

and black only EPS. 

The created equation will be sent as color EPS by default if there is any color equation. But you may 
also force to send in black&white EPS format even though color is used in the equation, by pressing a 
shift key when you choose "Save in InDesign" from the File menu or shift-command-S.

But the sent Black EPS still contain the original MathMagic document including color information so 
you may later edit the equation with color style information correctly.
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VII. Support

If you encounter problems using MathMagic, you may contact us for help at below address.

Customer Support and Technical Support 

Email: support@mathmagic.com
Internet: http://www.mathmagic.com/support/

Purchase Order, Bundle, Distribution
Please contact our sales dept. for purchasing, bundling or distributing MathMagic.

MathMagic Sales & Marketing Div.

Email: sales@mathmagic.com
Tel: +82 2 3676 4883
Fax: +82 2 3676 4882
http://www.mathmagic.com/store/

Source License, Custom Development
Contact us at below address for our source license program or custom development service.

Email: support@mathmagic.com
Tel: 1-604-468-8509

[ We proudly develop Macintosh software ]SM
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VIII. Appendix

1. Shortcut keys

1.1 Template shortcut keys

     All template shortcut keys start with  command-T.

cmd-9  or  cmd-0
cmd-T, 9 or 0

cmd-shift-9 or cmd-shift-0
cmd-T, shift-9 or shift-0 

cmd-[  or  cmd-]
cmd-T, [ or ]  

cmd-shift-[ or cmd-shift-]
cmd-T, shift-[ or shift-]

cmd-T, \

cmd-T, shift-\

cmd-F
cmd-T, F

cmd-shift-F
cmd-T, shift-F

cmd-capsLock-F
cmd-T, capsLock-F

cmd-T, D

cmd-T, shift-D

cmd-R
cmd-T, R

cmd-shift-R
cmd-T, shift-R

cmd-H or 
cmd-shift-H (OS X)
cmd-T, H

cmd-L
cmd-T, L

cmd-J 
cmd-T, J

cmd-T, U

cmd-T, shift-U

cmd-T, S

cmd-T, shift-S

cmd-T, capsLock-S

cmd-I
cmd-T, I

cmd-T, shift-I

cmd-capsLock-I
cmd-T, capsLock-I

cmd-T, P

cmd-T, shift-P

cmd-T, capsLock-P

cmd-T, N

cmd-T, shift-N

cmd-T, capsLock-N

cmd-T, M

cmd-shift-M
cmd-T, shift-M

cmd-capsLock-M
cmd-T, capsLock-M

cmd-B
cmd-T, B

cmd-/
cmd-T, /

cmd-shift-/
cmd-T, shift-/

cmd-capsLock-/
cmd-T, capsLock-/

cmd- - 
cmd-T, -

cmd-shift- - 
cmd-T, shift- -

cmd-capsLock- - 
cmd-T, capsLock- -

cmd- `
cmd-T, `

cmd- ~  or cmd-shift- `
cmd-T, ~ or shift- `

cmd-capsLock- `
cmd-T, capsLock- `

cmd- ' 
cmd-T, '

cmd- "  or cmd-shift-'
cmd-T, " or shift-'

cmd-capsLock- '
cmd-T, capsLock- '

cmd-T, .

cmd-T, shift- .

cmd-T, capsLock- .

cmd-T, A

cmd-T, shift-A

cmd-option-Tab

 MathMagic User Guide - Personal Edition & Pro Edition v5.0 97 



1.2 Symbol shortcut keys

     All symbol shortcut keys start with command-K.

cmd-K, C

cmd-K, shift-C

cmd-K, E

cmd-K, shift-E

cmd-K, U

cmd-K, shift-U

cmd-K, <

cmd-K, >

cmd-K, shift-<

cmd-K, shift->

cmd-K, =

cmd-K, shift- =

cmd-K, -

cmd-K, shift- -

cmd-K, T

cmd-K, shift-T

cmd-K, S

cmd-K, shift-S

cmd-K, A

cmd-K, shift-A

cmd-K, D

cmd-K, shift-D

cmd-K, O

cmd-K, shift-O

cmd-K, I

cmd-K, shift-I

1.3 Greek character shortcut keys

     All Greek symbols shortcut keys start with command-G.

cmd-G, shift-A

cmd-G, shift-B

cmd-G, shift-C

cmd-G, shift-D

cmd-G, shift-E

cmd-G, shift-F

cmd-G, shift-G

cmd-G, shift-H

cmd-G, shift-I

cmd-G, shift-K

cmd-G, shift-L

cmd-G, shift-M

cmd-G, shift-N

cmd-G, shift-O

cmd-G, shift-P

cmd-G, shift-Q

cmd-G, shift-R

cmd-G, shift-S

cmd-G, shift-T

cmd-G, shift-U

cmd-G, shift-W

cmd-G, shift-X

cmd-G, shift-Y

cmd-G, shift-Z

cmd-G, A

cmd-G, B

cmd-G, C

cmd-G, D

cmd-G, E

cmd-G, F

cmd-G, G

cmd-G, H

cmd-G, I

cmd-G, K

cmd-G, L

cmd-G, M

cmd-G, N

cmd-G, O

cmd-G, P

cmd-G, Q

cmd-G, R

cmd-G, S

cmd-G, T

cmd-G, U υϖ

cmd-G, W

cmd-G, X

cmd-G, Y

cmd-G, Z

cmd-G, J cmd-G, Vcmd-G, shift-J cmd-G, shift-V
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2. Editing keys
MathMagic supports commonly used editing keys in the equation editor window. Some keys are as followings.

Keyboard Behavior
right arrow Move  cursor to the right

At the end of a template box, move to the beginning of the next box
left arrow Move cursor to the left

At the beginning of a box, move to the end of previous box
down arrow Move to the same point of the next line
up arrow Move to the same point of the previous line

cmd-right arrow Move to the end of the line
cmd-left arrow Move to the beginning of the line
cmd-down arrow Move to the end of the document
cmd-up arrow Move to the beginning of the document

shift-right arrow Move cursor to the right, and select in-between contents
shift-left arrow Move cursor to the left, and select in-between contents
shift-down arrow Move to the same point of the next line, and select in-between contents
shift-up arrow Move to the same point of the previous line, and select in-between contents

option-right arrow Nudge(move) the current selection to the right 1-point of the current view
option-left arrow Nudge(move) the current selection to the left 1-point of the current view
option-down arrow Nudge(move) the current selection to the down 1-point of the current view
option-up arrow Nudge(move) the current selection to the up 1-point of the current view

home Move cursor to the begging of the current box or line
end Move cursor to the end of the current box or line
cmd-home Move cursor to the begging of the document
cmd-end Move cursor to the end of the document

shift-cmd-right arrow Move to the end of the line, and select in-between contents
shift-cmd-left arrow Move to the beginning of the line, and select in-between contents
shift-cmd-down arrow Move to the end of the document, and select in-between contents
shift-cmd-up arrow Move to the beginning of the document, and select in-between contents

tab Move cursor to the end of current box
At the end of a box, move to the beginning of the next box

shift-tab Move cursor to the beginning of current box
At the beginning of a box, move to the end of the previous box

return, enter Add a new line as a same level of current line
In the middle of a box, breaks the line and move the right part to the next line

delete (backward) Delete the left character of the cursor
If it is a template, select the box first and then delete it by another delete key

del  (forward delete) Delete the right-side character of the cursor
If it is a template box, just select the box

control Display Magic shortcut key tool tips for Templates and Symbols palette
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3. MathMagic font samples
Here are some of the MathMagic font samples. Some characters are not listed here even though the font is 

listed.

There are more fonts that are not listed here. 

New fonts may be provided from time to time for the registered users. If there are any character glyphs you 

wish to include in the future MathMagic font release, please feedback to our customer support team.

MMArrow

!"#$%&'()*+,./0123456789:;<=>?@

ABCDEFGHIJKLMNOPQRSTUVWXYZ[\]^_`ab

MMBinary

!"#$%&'()*+,./0123456789:;<=>?@ABCDEFGHIJKL
MNOPQRSTUVWXYZ[

MMCenturyOld

!"#$%&'()*+,./0123456789:;<=>?@ABCDEFGHIJKLMNO
PQRSTUVWXYZ[\]^_`abcdefghijklmnopqrstuvwxyz{|}~

MMCenturyOldE - Italic

!"#$%&'()*+,./0123456789:;<=>?@ABCDEFGHIJKLMNO
PQRSTUVWXYZ[\]^_`abcdefghijklmnopqrstuvwxyz{|}~

MMCenturyOldK

!"#$%&'()*+,./0123456789:;<=>?@ABCDEFGHIJKLMNO
PQRSTUVWXYZ[\]^_`abcdefghijklmnopqrstuvwxyz{|}~

MMCenturyOldK - Italic

!"#$%&'()*+,./0123456789:;<=>?@ABCDEFGHIJKLMNO
PQRSTUVWXYZ[\]^_`abcdefghijklmnopqrstuvwxyz{|}~

MMCenturyOldO - Italic

!"#$%&'()*+,./0123456789:;<=>?@ABCDEFGHIJKLMNO
PQRSTUVWXYZ[\]^_`abcdefghijklmnopqrstuvwxyz{|}~
MMCenturyOldGreek

ABCDEFGHIJKLMNOPQRSTUVWXabcdefghijkl
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mnopqrstuvwxyz{|}~!

MMEtc

!"#$%&'()*+,./0123456789:;<=>?@ABCDEFGHIJ
KLMNOPQRSTUVWXYZ[\]^_`abcdefghijlmnopqrstuvw
xyz{|}

MMGreek

ABCDEFGHIJKLMNOPQRSTUVWXabcdefghijkl
mnopqrstuvwxyz{|}~

MMNegate

!"#$%&'()*+,./0123456789:;<=>?@ABCDEFG
HIJKLMNOPQRSTUVWXYZ[\

MMRelation

!"#$%&'()*+,./0123456789:;<=>?@ABCDEF
GHIJKLMNOPQRSTUVWXYZ[\]^_`abcdefghi

MMTextbook

!"#$%&'()*+,./0123456789:;<=>?@ABCDEFGHIJKL
MNOPQRSTUVWXYZ[\]^_`abcdefghijklmnopqrstuvwxyz{|}~

MMTimes

!"#$%&'()*+,./0123456789:;<=>?@ABCDEFGHIJKLMNO
PQRSTUVWXYZ[\]^_`abcdefghijklmnopqrstuvwxyz{|}~

MMTimes - Italic

!"#$%&'()*+,./0123456789:;<=>?@ABCDEFGHIJKLMNO
PQRSTUVWXYZ[\]^_`abcdefghijklmnopqrstuvwxyz{|}~
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\above \abovewithdelims
\acute \acute
\aleph \Alpha

\alpha \amalg
\And \angle
\approx \approxeq

\arrowhorizex \arrowvertex
\ast \asymp
\atop \atopwithdelims

\backepsilon \backsim
\backsimeq \backslash
\backtriangle \bar

\bar \barwedge
\Bbbk \because
\Beta \beta

\beth \between
\bf \big
\bigcap \bigcap

\bigcirc \bigcup
\bigcup \Bigg
\bigg \Biggl

\biggl \Biggm
\biggm \Biggr
\biggr \Bigl

\bigl \Bigm
\bigm \bigodot
\bigodot \bigoplus

\bigoplus \bigotimes
\bigotimes \Bigr
\bigr \bigsqcup

\bigsqcup \bigstar
\bigtriangledown \bigtriangleup
\biguplus \biguplus

\bigvee \bigvee
\bigwedge \bigwedge
\binom \blacklozenge

\blacksquare \blacktriangle
\blacktriangledown \blacktriangleleft
\blacktriangleright \bordermatrix

\bot \bowtie
\Box \boxdot
\boxminus \boxplus

\boxtimes \bprime
\bprime \brace
\braceleftbt \braceleftex

\braceleftmid \bracelefttp
\bracerightbt \bracerightex
\bracerightmid \bracerighttp

\brack \bracketleftbt
\bracketleftex \bracketlefttp
\bracketrightbt \bracketrightex

\bracketrighttp \breve
\breve \buildrel
\bullet \Bumpeq

\bumpeq \Cap
\cap \cases
\cdot \centerdot

\check \check
\Chi \chi
\choose \circ

\circeq \circlearrowleft
\circlearrowright \circledast
\circledcirc \circleddash

\circledS \clubsuit
\complement \cong
\coprod \coprod

\cr \Cup
\cup \curlyeqprec
\curlyeqsucc \curlyvee

\curlywedge \curvearrowleft
\curvearrowright \dag
\dagger \daleth

\dashv \dbinom
\ddag \ddagger
\dddot \dddot

\ddot \ddot
\def \Delta
\delta \dfrac
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4. TeX codes supported by MathMagic

MathMagic supports these TeX codes when it imports and exports equation as a TeX format.



\diag \diagdown
\diagup \Diamond

\diamond \diamondsuit
\digamma \displaylines
\displaystyle \div

\divideontimes \dot
\dot \doteq
\doteqdot \dotplus

\doublebarwedge \doubleprime
\dover \Downarrow
\downarrow \downarrowhead

\downdownarrows \downharpoonleft
\downharpoonright \dvert
\ell \emptyset

\Epsilon \epsilon
\eqalign \eqalignno
\eqbase \eqbottom

\eqcenter \eqcirc
\eqleft \eqright
\eqslantgtr \eqslantless

\eqtop \equiv
\Eta \eta
\eth \exists

\fallingdotseq \Finv
\flat \font
\forall \frac

\from \frown
\fullstyle \Game
\Gamma \gamma

\gather \gdef
\geq \geqq
\geqslant \gg

\ggg \gimel
\gnapprox \gneq
\gneqq \gnsim

\grave \grave
\gtrapprox \gtrdot
\gtreqless \gtreqqless

\gtrless \gtrsim
\gvertneqq \halign
\hat \hat

\hbar \heartsuit
\hfill \hookleftarrow
\hookrightarrow \hslash

\iiint \iiint
\iint \iint

\Im \imath
\in \infty

\int \int
\integralbt \integralex
\integraltp \intercal

\Iota \iota
\it \jmath
\Join \Kappa

\kappa \Lambda
\lamda \langle
\langle \lbrace

\lbrace \lbracket
\lbracket \lceil
\lceil \leadsto

\left \Leftarrow
\leftarrow \leftarrowhead
\leftarrowtail \leftharpoondown

\leftharpoonup \leftleftarrows
\Leftrightarrow \leftrightarrow
\leftrightarrows \leftrightharpoons

\leftrightsquigarrow \leftthreetimes
\leq \leqalignno
\leqq \leqslant

\lessapprox \lessdot
\lesseqgtr \lesseqqgtr
\lessgtr \lesssim

\lfloor \lfloor
\lhd \limits
\ll \Lleftarrow

\lll \lnapprox
\lneq \lneqq
\lnsim \longleftarrow

\longleftrightarrow \longrightarrow
\looparrowleft \looparrowright
\lozenge \lparen

\lparen \Lsh
\ltimes \lvertneqq
\mapsto \mathbin

\mathclose \mathop
\mathopen \mathord
\mathpunct \mathrel

\matrix \measuredangle
\medspace \mho
\mid \mid

\midbar \models
\mp \Mu
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\mu \multimap
\natural \ncong

\nearrow \neg
\neq \nexists
\ngeq \ngeqq

\ngeqslant \ngtr
\ni \nLeftarrow
\nLeftrightarrow \nleftrightarrow

\nleq \nleqq
\nleqslant \nless
\nmid \noalign

\nolimits \not
\notin \nparallel
\nprec \npreceq

\nRightarrow \nrightarrow
\nshortmid \nshortparallel
\nsim \nsubseteq

\nsubseteqq \nsucc
\nsucceq \nsupseteq
\nsupseteqq \ntriangleleft

\ntrianglelefteq \ntriangleright
\ntrianglerighteq \Nu
\nu \nVDash

\nVdash \nvDash
\nvdash \nwarrow
\odot \of

\oiiint \oiiint
\oiint \oiint
\oint \oint

\Omega \omega
\Omicron \omicron
\ominus \operatorname

\operatornamewithlimits \oplus
\oslash \otimes
\over \overbrace

\overbrace \overbracebt
\overbraceex \overbracemid
\overbracetp \overbracket

\overbracket \overbracketbt
\overbracketex \overbrackettp
\overeq \overleftarrow

\overleftrightarrow \overline
\overparen \overparen
\overparenbt \overparenex

\overparentp \overrightarrow
\oversetbrace \overwithdelims

\P \parallel
\parallel \parenleftbt

\parenleftex \parenlefttp
\parenrightbt \parenrightex
\parenrighttp \partial

\perp \Phi
\phi \Pi
\pi \pitchfork

\pm \pmatrix
\prec \precapprox
\preccurlyeq \preceq

\precnapprox \precneqq
\precnsim \precsim
\prime \prime

\prod \prod
\propto \Psi
\psi \qquad

\quad \rangle
\rangle \rbrace
\rbrace \rbracket

\rbracket \rceil
\rceil \Re
\rfloor \rfloor

\rhd \Rho
\rho \right
\Rightarrow \rightarrow

\rightarrowhead \rightarrowtail
\rightharpoondown \rightharpoonup
\rightleftarrows \rightleftharpoons

\rightrightarrows \rightsquigarrow
\rightthreetimes \risingdotseq
\rm \root

\rparen \rparen
\Rrightarrow \Rsh
\rtimes \S

\sb \scriptarrowhorizex
\scriptarrowvertex \scriptdownarrowhead
\scriptleftarrowhead \scriptrightarrowhead

\scriptscriptstyle \scriptstyle
\scriptsymbolstyle \scriptuparrowhead
\shortparallel \Sigma

\sigma \sim
\simeq \size
\skew \slash

\smallfrown \smallint
\smallsetminus \smallsmile
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\smile \sp
\space \spadesuit

\sphericalangle \sqcap
\sqcup \sqrt
\sqsubset \sqsubseteq

\sqsupset \sqsupseteq
\square \star
\struct \Subset

\subset \subseteq
\subseteqq \subsetneq
\subsetneqq \succ

\succapprox \succcurlyeq
\succeq \succnapprox
\succneqq \succnsim

\succsim \sum
\sum \Supset
\supset \supseteq

\supseteqq \supsetneq
\supsetneqq \surd
\swarrow \symbolstyle

\Tau \tau
\tbinom \tdiag
\text \textstyle

\tfrac \therefore
\Theta \theta
\thickapprox \thickfrac

\thicksim \thickspace
\thinspace \tilde
\tilde \times

\to \top
\tover \triangle
\triangledown \triangleleft

\trianglelefteq \triangleq
\triangleright \trianglerighteq
\triangleup \tripleprime

\twoheadleftarrow \twoheadrightarrow
\underbrace \underbrace
\underbracebt \underbraceex

\underbracemid \underbracetp
\underbracket \underbracket
\underbracketbt \underbracketex

\underbrackettp \undereq
\underleftarrow \underleftrightarrow
\underline \underparen

\underparen \underparenbt
\underparenex \underparentp

\underrightarrow \undersetbrace
\unlhd \unrhd

\Uparrow \uparrow
\uparrowhead \Updownarrow
\updownarrow \upharpoonleft

\upharpoonright \uplus
\Upsilon \upsilon
\upuparrows \varepsilon

\varkappa \varnothing
\varphi \varpi
\varpropto \varrho

\varsigma \varsubsetneq
\varsubsetneqq \varsupsetneq
\varsupsetneqq \vartheta

\vartriangle \vartriangleleft
\vartriangleright \Vdash
\vDash \vdash

\vec \vec
\vee \veebar
\Vert \vert

\Vvdash \wedge
\xint \xoiiint
\xoiint \xoint

\Zeta \zeta
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MathMagic, MathMagic XTension, MathMagic Viewer, MathMagic Personal Edition, MathMagic Pro Edition, MathMagic 

Prime Edition, [Math+Magic], MathMagic logo, and InfoLogic are trademarks or registered trademarks of InfoLogic, Inc.

InDesign, InCopy, Postscript are trademarks or registered trademarks of Adobe Systems Incorporated.

Quark, QuarkXPress, Quark XTensions are trademarks or registered trademarks of Quark, Inc.

Macintosh, Mac OS, Mac OS X, Mac OS Classic, AppleWorks, Power Macintosh are trademarks or registered trademarks 
of Apple Computer, Inc.

All other trademarks may be the properties of their respective owners.
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